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Chapter 1. Introduction

The IBM® System Storage™ DS3000 Storage Manager Version 2 (referred to
throughout this document as Storage Manager software) is host software that you
can use to manage your storage subsystems.

This document provides information about how to prepare, install, configure, and
work with the Storage Manager software in each of the following operating systems:

+ IBM AIX® version 5.2 and IBM AIX version 5.3

+ Red Hat Enterprise Linux® 4 (RHEL 4)

* Red Hat® Enterprise Linux 5 (RHEL 5)

* SUSE Linux Enterprise Server 9 (SLES 9)

» SUSE Linux Enterprise Server 10 (SLES 10) and SUSE Linux Enterprise Server
10 Service Pack 1

For an interoperability matrix that lists the operating systems that are supported by

the Storage Manager software, see the following Web sites:

» For the DS3200: |http://www.ibm.com/systems/storage/disk/ds3000/ds3200

» For the DS3300: |http://www.ibm.com/systems/storage/disk/ds3000/ds3300

* For the DS3400: |http://www.ibm.com/systems/storage/disk/ds3000/ds3400.

Obtaining the documentation from the IBM Support Web site

If firmware and documentation updates are available, you can download them from
the IBM support Web site. The Storage Manager software might have features that
are not described in the documentation that comes with the unit, and the
documentation might be updated occasionally to include information about those
features, or technical updates might be available to provide additional information
that is not included in the storage subsystem documentation. To check for updates,
complete the following steps:
1. Go to http://www.ibm.com/servers/storage/support/
2. Under Select your product, in the Product Family field, click Disk systems.
3. In the Product field, click IBM System Storage DS3200, IBM System Storage
DS3300, or IBM System Storage DS3400, as applicable.
4. Click Go.
5. Make the following selections:
* For firmware updates and readme files, click the Download tab.

* For documentation updates, click the Install and use tab.

Note: Changes are made periodically to the IBM Web site. Procedures for locating
firmware and documentation might vary slightly from what is described in this
document.

Notices in this

document

The following notices are used in this document:
* Note: These notices provide important tips, guidance, or advice.

» Important: These notices provide information or advice that might help you avoid
inconvenient or problem situations.

© Copyright IBM Corp. 2007 1
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Attention: These notices indicate potential damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in which
damage might occur.

Storage Manager software online help and diagnostics

When you are finished with the installation process, see the following online help
systems:

Enterprise Management window help

Use this online help system to learn more about working with the entire
management domain.

Subsystem Management window help

Use this online help system to learn more about managing individual storage
subsystems.

You can access these help systems from within the Storage Manager Client. From
either an Enterprise Management or Subsystem Management window, click Help or
press F1.

Premium features

Premium features provide enhanced functionality that enables you to perform tasks
that might be limited or unavailable with your base storage subsystem model. For
more information, see [Chapter 7, “Enabling and using premium features,” on page

You can purchase the following premium features for a DS3000 storage subsystem:

DS3200 Software Feature Pack

DS3300 Software Feature Pack

DS3400 Software Feature Pack

DS3000 FlashCopy® Expansion License
DS3000 Volume Copy License

DS3000 FlashCopy Volume Copy License
DS3000 Partition Expansion License

Software Feature Pack

Each DS3000 storage subsystem has it own unique Software Feature Pack
option that works on only that specific storage subsystem model. For
example, a DS3200 Software Feature Pack key does not work on a
DS3300 storage subsystem.

The software feature pack:

* Unlocks the DS3000 storage subsystem so that additional premium
features, such as FlashCopy or VolumeCopy, can be used.

* Unlocks the drive expansion ports so that additional drive expansion
enclosures can be connected to the DS3000 storage subsystem.

* Provides an additional two partitions, which brings the total number of
partitions to four.

2 DS3000 Storage Manager Installation and Support Guide for AIX and Linux on POWER



FlashCopy
The FlashCopy feature supports the creation and management of
FlashCopy logical drives. A FlashCopy logical drive is a logical point-in-time
image of another logical drive, called a base logical drive, that is in the
storage subsystem. A FlashCopy image is the logical equivalent of a
complete physical copy, but you create it much more quickly and it requires
less disk space.

Because a FlashCopy image is a host-addressable logical drive, you can
perform backups by using the FlashCopy image while the base logical drive
remains online and user-accessible. You can also write to the FlashCopy
logical drive to perform application testing or scenario development and
analysis. The maximum number of FlashCopy logical drives that are
allowed is one-half of the total number of logical drives that are supported
by your controller model.

VolumeCopy
The VolumeCopy feature is a firmware-based mechanism for replicating
logical drive data within a storage array. This feature is designed as a
system management tool for tasks such as relocating data to other drives
for hardware upgrades or performance management, data backup, or
restoring FlashCopy logical drive data.

You submit VolumeCopy requests by specifying two compatible drives. One
drive is designated as the Source and the other as the Target. The
VolumeCopy request is persistent so that any relevant result of the copy
process can be communicated to you.

Note: The terms VolumeCopy and Logical Drive Copy are used
interchangeably throughout this document, the Storage Manager
Client program interface, and the online help.

Partition Expansion

You can use the Partition Expansion feature to present all of the defined
logical drives in a storage subsystem to a SAN, through several different
partitions. You can do this by mapping each logical drive to a LUN (0 - 31)
in each of the defined partitions. A logical drive can be mapped to only one
partition at a time. In a storage partition, the mapped logical drives are
accessible only to the host server or servers whose host bus adapter host
ports are defined in that storage partition. This feature enables the DS3000
storage subsystem to act as a multiple virtual storage subsystem to the
host server.

Partition Expansion also enables multiple hosts that use different operating

systems, with their own unique disk storage subsystem settings, to connect
to the same DS3000 storage subsystem at the same time. This is known as
a heterogeneous host environment.
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Terms to know

For more information about terminology, see the online help in the Storage Manager
Enterprise Management window or the Storage Subsystem Management window.

It is important to understand the distinction between the following two terms when
you read this document.

Management station
A management station is a system that is used to manage a DS3000
storage subsystem. You can connect a management station to the storage
subsystem by using either of the following methods:

» Through a TCP/IP Ethernet connection to the controllers in the storage
subsystem (out-of-band method)

» Through a TCP/IP connection to the host-agent software that is installed
on a host server, which in turn is directly attached to the storage
subsystem through the input/output (I/O) path (in-band method)

For more information, see [‘Storage subsystem management methods” on|

Host server
A host server is a server that is connected directly to a DS3000 storage
subsystem through the 1/O path. This server is used to perform the following
tasks:
» Serve data (typically in the form of files) from the storage subsystem

* Function as a connection point to the storage subsystem for a
remote-management station

Notes:

1. The terms host and host server are used interchangeably throughout
this document.

2. A host server can also function as a management station.
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Hardware requirements

lists the hardware requirements for installing the Storage Manager 2

software.

Table 1. Hardware requirements for the Storage Manager 2 software

Hardware component

Requirements

Management station (for
client software)

The management station computer requires the following
hardware:

IBM System p™ or IBM BladeCenter® POWER™ server with
64-bit PowerPC® architecture

CD drive

Mouse or similar pointing device

System memory minimum of 256 MB (512 MB preferred)
Ethernet network interface adapter

Video adapter capable of a minimum of 800 x 600
resolution.

Monitor setting of 1024 x 768 pixels with 64 000 colors. The
minimum display setting that is allowed is 800 x 600 pixels
with 256 colors.

Important: Some servers are not designed to run
graphic-intensive software. If your server has difficulty
displaying the Storage Manager user interface, you might
have to upgrade the server video adapter or use the
command-line interface (CLI).

For more information about host adapters, fabric switches, and managed hubs, see
the following ServerProven® and interoperability Web sites:

|http://www.ibm.com/servers/eserver/serverproven/compat/us/|

lhttp://www.ibm.com/systems/storage/disk/ds3000/ds3200/|

Ihttp://www.ibm.com/systems/storage/disk/ds3000/ds3300/|

bhttp://www.ibm.com/systems/storage/disk/ds3000/ds3400/|

AIX software requirements

The Storage Manager software requirements and the IBM AIX operating system
requirements are described in the following sections.

Storage Manager software requirements

[Table 2 on page 6|lists the disk space and administrator privileges that are required
to install the Storage Manager software in an AIX environment.

Note: The disk space that is listed in[Table 2 on page 6| is for the packages after
the installation. During the installation of each software package, you might
need up to 170 MB of free disk space.
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Table 2. Installation requirements for AIX by software package

Package Disk space requirement for AIX
SMclient 130 MB

MPIO 2 MB

SMagent 1 MB

50 MB (if SMclient is not installed)

SMutil 2 MB

AIX operating system requirements

The management station or host server requires one of the following operating
systems.

Important: For the latest supported operating system and host software versions,
see the Storage Manager readme files and see |http://www.ibm.com/|
lservers/eserver/serverproven/compat/us/|

¢ |IBM AIX version 5.2
¢ IBM AIX version 5.3

Linux on POWER software requirements
The Storage Manager software requirements and the Linux operating system
requirements are described in the following sections.

Storage Manager software requirements

lists the disk space that is required for installing the Storage Manager
software in a Linux environment.

Table 3. Installation requirements for Linux by software package

Package Disk space requirement

Storage Manager Client (SMclient) 165 MB in /opt, 2 MB in /tmp, 1 MB in /var
Linux MPP 2 MB

Storage Manager Agent (SMagent) 2 MB in /opt

Storage Manager Utility (SMutil) 7 MB in /opt

Linux operating system requirements
The following kernel levels are required for Linux operating systems:
* 2.6 kernel (RHEL 4, SLES 9, and SLES 10) for RDAC Revision B
» 2.6 kernel (RHEL 5 and SLES 10 SP1) for RDAC Revision C

For the latest supported Linux operating systems, details about device driver levels,

and instructions for multipath configurations for Linux support, see the Storage
Manager software readme files.
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Storage subsystem management methods

The Storage Manager software provides the following two methods for managing
storage subsystems:

* The host-agent (in-band) management method (DS3300 and DS3400 only)
* The direct (out-of-band or Ethernet) management method

If you establish management connections from multiple management stations or
hosts to the same DS3000 storage subsystem, it is best practice to have only one
active management connection to the DS3000 storage subsystem at a time, even
though eight simultaneous active management sessions are supported in a DS3000
storage subsystem.

Host-agent (in-band) management method

When you are using the host-agent (in-band) management method, you manage
the storage subsystems through the 1/O path to the host. The management
information can either be processed in the host or be passed to the management
station through the network connection, as shown in

Host computer

“«——— 1/0 path

’ Controller ‘ Bl

’ Controller ‘ *******

Storage subsystems

<+— Ethernet

Management station
(one or more)

Figure 1. Host-agent (in-band) managed storage subsystems

Managing storage subsystems through the host-agent has the following
advantages:

* You do not have to connect Ethernet cables to the controllers.

* You do not need a Dynamic Host Configuration Protocol/Bootstrap Protocol
(DHCP/BOOTP) server to connect the storage subsystems to the network.

* You do not have to perform the controller network configuration tasks that are
described in |Chapter 2, “Preparing for installation,” on page 17
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* You must specify only a host name or IP address for the host instead of for the
individual controllers in a storage subsystem. Storage subsystems that are
attached to the host are automatically discovered, if the host-agent service is
installed and running.

Managing storage subsystems through the host-agent has the following
disadvantages:

» The host-agent requires a special logical drive, called an access logical drive, to
communicate with the controllers in the storage subsystem. Therefore, you are
limited to configuring one fewer logical drive than the maximum number that is
allowed by the operating system and the host adapter that you are using.

* |f the connection through the 1/O path is lost between the host and the storage
subsystem, you cannot manage or monitor the storage subsystem.

Note: The access logical drive is also referred to as the Universal Xport Device.

Important: If the maximum number of logical drives are configured in the host,
either use the direct-management method or give up a logical drive for
use as the access logical drive. For more information, see
lsupported logical drives” on page 15

Required host-agent (in-band) management activities

To establish host-agent (in-band) management connections, complete the following

general tasks:

1. Make the I/O connections between the DS3000 storage subsystem and the host
server.

2. Install TCP/IP on the host server and establish a host IP address. For
instructions for host-managed systems, see [‘Overview of network installation|
[tasks” on page 18]

3. Install the host bus adapter device driver, SMclient, RDAC (MPIO for AlX, Linux
MPP for Linux), and SMagent on the host server.

4. Make sure that the Storage Manager Agent Service starts successfully:
For AIX and Linux: Type ps -elf | grep SMagent

5. Open the Storage Manager Enterprise Management window and add the IP
address of the host server to the management domain. All DS3000 devices that
are recognized by the host server are displayed in the Enterprise Management
window.

Direct-management (out-of-band) method

When you use the direct-management (out-of-band) method, you manage storage
subsystems directly over the network through a TCP/IP Ethernet connection to each
controller. To manage the storage subsystem through the Ethernet connections, you
must define the IP address and host name for each controller. Each of the storage
subsystem controllers must be connected, through a cable that is connected to the
RJ-45 connector, to an Ethernet network, as shown in|Figure 2 on page S{

The following illustration shows a system in which storage subsystems are
managed by using the direct-management (out-of-band) method.
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Host computer

“«——— /O path

’ Controller ‘ ***** J

<+— Ethernet

’ Controller ‘ *******

Storage subsystems

Management station
(one or more)

Figure 2. Direct-management (out-of-band) storage subsystems

Managing storage subsystems by using the direct-management (out-of-band)
method has the following advantages:

The Ethernet connections to the controllers enable you to manage storage
subsystems that are connected to a host running any of the operating systems
that Storage Manager supports through an SMclient management station.

You do not need an access logical drive to communicate with the controllers. You
can configure the maximum number of logical drives that are supported by the
operating system and the host bus adapter that you are using.

You can manage and troubleshoot the storage subsystem when there are
problems with the Fibre Channel, Internet SCSI (iISCSI), or SAS links.

Managing storage subsystems by using the direct-management (out-of-band)
method has the following disadvantages:

In a dual-controller storage subsystem configuration, you need two Ethernet
cables to connect the storage subsystem controllers to a network.

When you add devices, you must specify an IP address or host name for each
controller.

Network preparation tasks are required. For a summary of the preparation tasks,
see [Chapter 2, “Preparing for installation,” on page 17.

Important:

* To avoid DHCP/BOOTP server and network tasks, use the controller
default TCP/IP addresses or assign static IP addresses to the
controller (see[Table 4 on page 10).

» Create a separate private network aside from the main production
network for managing your DS3000 storage subsystems.
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Defining controller TCP/IP addresses
The following table shows the default settings for the storage subsystem controllers.

Table 4. Default controller TCP/IP addresses

Controller IP address Subnet mask
A 192.168.128.101 255.255.255.0
B 192.168.128.102 255.255.255.0

To change the DS3000 storage subsystem controller default TCP/IP address, you
must first make a direct-management connection to the storage subsystem by using
the default TCP/IP addresses.

To change the controller default TCP/IP address by using the Storage Manager

Client program, complete the following steps:

1. In the Enterprise Management window, double-click the storage subsystem for
which you want to define new controller TCP/IP addresses. The Subsystem
Management window opens.

2. Click the Tools tab.

3. On the Tools page, click Change Network Configuration. The Change Network
Configuration window opens.

FEESIMPLEX IBM System Storage DS3000 Ste

Tools > Change hetwork Configuration

Change Network Configuration

Host rar SIMPLEX _CtlA
Ethernet port; 1

MAC ardress: 00:a0:h&1d 203

Subnet mask: |255.25500
Gateway oo

Figure 3. Change Network Configuration window

4. Select the applicable controller tab and enter the applicable TCP/IP address
information for both controllers A and B.

5. Click OK to apply the new TCP/IP addresses.

Important: Make sure that the new TCP/IP address information is correct

because you will not be able to make a direct management
connection to the storage subsystem again by using the controller
default TCP/IP addresses after they are changed to different values.

6. Close the Subsystem Management window.
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7.

In the Enterprise Management window, delete the storage subsystem entry that
contains the default TCP/IP addresses.

Wait approximately 5 minutes, and then re-establish the management
connection to the storage subsystem by using the new TCP/IP addresses.

Note: You might want to ping the new addresses first to make sure that there is
a good network connection to the controllers before you add the storage
subsystem into the Enterprise Management window.

Required direct-management (out-of-band) management
activities

To establish a direct-management connection, complete the following steps:

1.

Make the Ethernet connections between the DS3000 storage subsystems and
the Ethernet network.

Follow the instructions in|[‘Overview of network installation tasks” on page 18| for
direct-managed systems.

Install SMclient.

Start the Storage Manager software and add the IP addresses for the DS3000
controllers (A and B). If you have multiple DS3000 storage subsystems, add
each |IP address to the domain.
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Reviewing a sample network

The following illustration shows an example of a network that contains both a
direct-managed storage subsystem (Network A) and a host-agent-managed storage
subsystem (Network B).

Network A
TCP/IP Ethernet
1/0O path
Storage
subsystem

| | e | | |

Network Host computer  i___| || Management DHCP/BOOTP
management Denver | station server
station (IP address -1 — (one or more)
(for SNMP traps) 192.168.128.112) Host name: Denver_a
(IP address 192.168.128.101)
hardware address 00.a0.b8.02.04.20
Host name: Denver_b

Router (IP address 192.168.128.102)
hardware address 00.a0.b8.00.00.d8

Network B
TCP/IP Ethernet

1/O path

Storage
subsystem

Host computer ] Controller Managgment
Atlanta 3 station
(IP address ~ *---1 Controller (one or more)

192.168.2.22)

Figure 4. Sample network using direct-managed and host-agent managed storage
subsystems

Direct-managed storage subsystem

In|Figure 4} Network A is a direct-managed storage subsystem. Network A contains
the following components:

« A DHCP/BOOTP server

* A network management station (NMS) for Simple Network Management Protocol
(SNMP) traps

* A host that is connected to a storage subsystem through a Fibre Channel, iSCSI,
or SAS /O path

* A management station that is connected by an Ethernet cable to the storage
subsystem controllers

Note: If you use the controller static TCP/IP addresses or default TCP/IP
addresses, you do not have to setup the DHCP/BOOTP server.
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Host-agent-managed storage subsystem

In[Figure 4 on page 12, Network B is a host-agent-managed storage subsystem.
Network B contains the following components:

» A host that is connected to a storage subsystem through a valid 1/O path
* A management station that is connected by an Ethernet cable to the host server

Creating a SAN-attached configuration (Fibre Channel)

This section contains the following topics:

* Preparing for a SAN-attached configuration

» Steps for setting up a SAN-attached configuration

» Connecting host bus adapters in a Fibre Channel switch environment

Preparing for a SAN-attached configuration
Before you create a SAN-attached configuration, read the following information:

* Make sure that multiple host bus adapters within the same server cannot "see”
the same DS3400 controller port.

* A multipath configuration requires two host bus adapters per host system, each
in a separate switch zone that is connected to one of the two controllers.

» Each Fibre Channel host bus adapter on each host, and the controller port on
each DS3000 storage subsystem, should be in its own fabric zone, if they are
connecting through a single Fibre Channel switch. If multiple adapters or
controller ports are in the same zone, you might encounter extended failover
delays or additional failovers because device resets are being propagated
throughout the zone.

Note: Single host bus adapter configurations are allowed. If you have a single host
bus adapter in a SAN-attached configuration, the controller must have a
Fibre Channel connection to the host bus adapter through a switch, and both
controllers must be within the same SAN zone as the host bus adapter.

Attention: If a path fails in a single host bus adapter configuration, a loss of data
access can occur.

Setting up a SAN-attached configuration
To set up a SAN-attached configuration, complete the following steps:
1. Connect the host bus adapters to the switch or switches.
2. Connect the DS3000 storage subsystems to the switch or switches.
3. Set the required zones on the Fibre Channel switch or switches, if applicable.

Note: For information about zoning and enabling zones, see the documentation
that comes with the switch.
4. Configure the system, and then verify the configuration by logging in to the
switch to view the system.

For more information about setting up a DS3000 storage subsystem, see the Quick

Installation Guide and the other documentation on the support CD that comes with
the storage subsystem.
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Connecting host bus adapters in a Fibre Channel switch environment

When you connect Fibre Channel host bus adapters in host servers to DS3000
storage subsystem host ports in a Fibre Channel switch environment, you should
establish one-to-one zones between the host bus adapter and DS3000 host ports. If
multiple adapters or controller ports are in the same zone, you might encounter
extended failover delays or additional failovers because device resets are being
propagated throughout the zone.

For instructions for setting up a zone inside a Fibre Channel switch, see the
documentation that comes with the Fibre Channel switch.

You can find links to switch documentation at http://www.ibm.com/servers/storagel/|
Isupport/san/index.html]

Standard (noncluster) configuration

You can install the Storage Manager software in a standard (noncluster)
configuration.

Figure 5| shows a sample standard (noncluster) configuration.

MPIO (for Windows),
MPP (for Linux),
SMutil, SMagent

Host computer

“«———1/0 path

’ Controller ‘ ***** i
§ The SMclient software
‘ fffffff can also be installed
on the host computer.

’ Controller

Storage subsystems

SMclient

<+— Ethernet

Management station

Figure 5. Sample standard (noncluster) configuration

14 DS3000 Storage Manager Installation and Support Guide for AIX and Linux on POWER


http://www.ibm.com/servers/storage/support/san/index.html
http://www.ibm.com/servers/storage/support/san/index.html

Number of supported logical drives

The supported logical drive limits for AIX and Linux on POWER are shown in the

following table.

Table 5. Maximum number of logical drives per storage subsystem

Maximum logical
drives

Maximum logical
drives per storage
unit partition

Maximum
FlashCopy logical
drives

Maximum Logical
Drive Copy logical
drives

256

32 (See note[t])

128

255

Notes:

1.

A maximum of four partitions is supported for base DS3000 models. To upgrade
from 4 to 16 partitions, you must purchase the DS3000 Partition Expansion
License.

Each standard logical drive supports a maximum of four FlashCopy logical
drives.

The host-agent management method uses a special logical drive, called an
access logical drive, to communicate with the controllers on the storage
subsystem. The access logical drive uses one of the available LUNs. Therefore,
managing storage subsystems with the host-agent software limits you to one
fewer LUN than the maximum number that is supported by the operating system
and the host adapter. The access logical drive is also referred to as the
Universal Xport Device.
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Chapter 2. Preparing for installation

This chapter provides information to help you plan the installation of the Storage

Manager software.

See the applicable sections in this document to install the Storage Manager 2 Client
and host software for a particular operating system. When you have completed the
Storage Manager 2 software component installation procedures, perform the

rocedures in [Chapter 5, “Completing the Storage Manager software installation|

and configuration,” on page 75[and|Chapter 6, “Completing storage-management|

tasks,” on page 103

Planning and preparing for an AIX installation

shows the installation sequence for the Storage Manager software
components and provides information to help you plan for the installation of the
Storage Manager software for AlX.

Table 6. Software component installation sequence in an AlX environment

System type

Software installation sequence

Management station
(and any host server
in use as a

management station)

Storage Manager Client (SMclient)

Host server

IBM AIX 5.2 or 5.3 and the required APARS
IBM host bus adapter device driver
IBM AIX MPIO PCM (required)

Multipath I/O (MPIO) path-control module (PCM) is installed as
the failover driver for AIX.

Storage Manager host software package, which can install the
following components:

* SMclient (optional)

SMclient is required if you manage the storage subsystem from
the host server.

MPIO (required)

MPIO is installed as the RDAC failover driver for AlX.
SMagent (optional)

SMagent is installed when you select the Typical Installation
option in the Storage Manager installation wizard. It is required
if you use the host-agent management method.

SMutil (optional)

SMutil contains the hot_add, SMdevices, and SMrepassist
utilities.
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Planning and preparing for a Linux installation

shows the installation sequence for the Storage Manager software
components and provides information to help you plan for the installation of the
storage management software for Linux.

Table 7. Software component installation sequence in a Linux environment

System type Software installation sequence

Management station | Storage Manager Client (SMclient)
(and any host server
in use as a

management station)

Host server and

IBM host bus adapter device driver (Linux version)
cluster node

2. Linux MPP (required)
Linux MPP is installed as the RDAC failover driver for Linux.

3. Storage Manager host software package, which can install the
following components:

» SMclient (optional)
SMclient is required if you manage the storage subsystem from
the host server.

* SMagent (optional)
SMagent is required if you use the host-agent (in-band)
management method. You must first install Linux MPP (see step

@). The direct (out-of-band) management method is preferred in
a Linux environment.

*  SMuitil (required)

SMutil contains the hot_add, SMdevices, and SMrepassist
utilities.
4. Host bus adapter management software (optional)

Note: Linux MPP is provided separately from the Storage Manager host software
package. There are two Linux MPP packages, one for each type of kernel:

e 2.6 kernel (RHEL 4, SLES 9, and SLES 10) for RDAC Revision B
* 2.6 kernel (RHEL 5 and SLES 10 SP1) for RDAC Revision C

Overview of network installation tasks

To begin installing the storage management software, make sure that the network
components are set up and operating correctly, and that you have the host and
controller information that is required for the software to operate correctly.

The following sections provide an overview of the tasks that are involved in setting
up a network installation for direct-managed and host-managed storage
subsystems.

Direct-managed storage subsystems: Network installation overview

Setting up a network installation of a direct-managed system involves the following
general tasks:

1. Install all hardware components (host servers, storage subsystems, and cables)
that you want to connect to the network. For installation information, see the
documentation that comes with the specific hardware device.
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Host-managed

7.

Establish a naming convention for the storage subsystems that are connected to
the network. For more information, see [‘Step 1: Naming the storage|
[subsystems” on page 20

Record the storage subsystem names and management types inlAppendix A,|

|“Storage subsystem and controller information record,” on page 109.]An
example of a completed information record is shown in[Table 8 on page 20,

Note: Throughout the remaining steps, return to|Appendix A, “Storage|
|subsystem and controller information record,” on page 109 to record
information such as hardware Ethernet addresses and IP addresses.

If you are using a default controller IP address, go to step@ Otherwise, obtain
the TCP/IP address and host name for each of the controllers in the storage
subsystems on the network from the network administrator. See |“Step 31
[Assigning IP addresses to hosts and controllers” on page 21|

Use controller static IP addresses (preferred); otherwise, set up a
DHCP/BOOTP server to provide network configuration information for a specific
controller.

Make sure that the TCP/IP software is installed. For more information, see |“Ste5|
4: \erifying the TCP/IP protocol and setting up the host or DNS table” on pagel
21.

Power-on the devices that are connected to the network.

systems: Network installation overview

The following steps provide an overview of the tasks that are involved in setting up
a network installation of a host-managed system:

1.

Install all hardware components (host servers, storage subsystems, and cables)
that you want to connect to the network. For installation information, see the
documentation that comes with the specific hardware device.

Establish a naming convention for the storage subsystems that are connected to
the network. For more information, see [‘'Step 1: Naming the storage|
[subsystems” on page 20

Record the storage subsystem names and management types in|ﬂppendix A,|
[‘Storage subsystem and controller information record,” on page 109.]An
example of a completed information record is shown in[Table 8 on page 20

Note: Throughout the remaining steps, return to|Appendix A, “Storage|
[subsystem and controller information record,” on page 109 to record
information such as hardware Ethernet addresses and IP addresses.

Obtain the IP address and host name of the host server on which the
host-agent software will run from the network administrator. See f‘Step 3:|
[Assigning IP addresses to hosts and controllers” on page 21|

Note: Host-managed storage subsystems are supported with the DS3300 and
DS3400 only.

Make sure that the TCP/IP software is installed. For more information, see |“Ste;_)|
4: Verifying the TCP/IP protocol and setting up the host or DNS table” on pagef

o1]

Power-on the devices that are connected to the network.
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Step 1: Naming the storage subsystems

As you set up your network, decide on a naming convention for the storage
subsystems. When you install the storage management software and start it for the
first time, all storage subsystems in the management domain are displayed as
<unnamed>. Use the Subsystem Management window to rename the individual
storage subsystems.

Consider the following factors when you name storage subsystems:

* There is a 30-character limit. All leading and trailing spaces are deleted from the
name.

» Use a unique, meaningful naming scheme that is easy to understand and
remember.

* Avoid arbitrary names or names that might quickly lose their meaning.

* The software adds the prefix Storage Subsystem when storage-subsystem names
are displayed. For example, if you name a storage subsystem Engineering, it is
displayed as Storage Subsystem Engineering.

Step 2: Recording the storage subsystem names

After you decide on a naming scheme, record the storage subsystem names in the
blank information record form in|Appendix A, “Storage subsystem and controlleq
linformation record,” on page 109).

Table 8! shows a sample information record for the network shown in

age 12| This network contains storage subsystems that are managed by using
both the direct-management and host-agent-management methods.

Table 8. Sample information record

Storage Management | Controllers: IP addresses and Host-IP address

subsystem name | method host nhame and host name
Controller A Controller B

Finance Direct IP address = IP address =

192.168.128.101 |192.168.128.102

Host = Denver_a | Host = Denver_b

Engineering Host-agent IP address =
192.168.2.22

Host = Atlanta
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Step 3: Assigning IP addresses to hosts and controllers

If you plan to manage your storage subsystem by using the out-of-band
management (direct-management) method, assign a unique IP address for every
controller in all storage subsystems on the network. Record the IP address for each
controller in the information record (Appendix A, “Storage subsystem and controller|
linformation record,” on page 109).

Note: To avoid performing DHCP/BOOTP server and network tasks, use the
controller default TCP/IP addresses or assign static IP addresses to the
controllers. If you are not able to use the controller default TCP/IP address to
assign the static TCP/IP address, see the information in ['Direct-management
{(out-of-band) method” on page 8.|

You can establish the out-of-band management connection to the DS3000 storage
subsystem by using the default IP addresses of 192.168.128.101 for controller A
and 192.168.128.102 for controller B. You can change the IP addresses by using
the Storage Manager Client Subsystem Management window.

For host-agent management only: If you plan to manage the DS3300 or DS3400
storage subsystem by using the host-agent management method, assign an IP
address for each host on which you will install the host-agent software. Record the
IP address for each host in the information record in|[Appendix A, “Storagel
subsystem and controller information record,” on page 109} then, go to[‘Step 4|
Verifying the TCP/IP protocol and setting up the host or DNS table.”|

Step 4: Verifying the TCP/IP protocol and setting up the host or DNS
table

The default installation process installs the TCP/IP software package. To make sure
that TCP/IP software package was installed successfully, open a shell prompt and
type ifconfig. If you see an ethO or eth1 interface, the IP protocol is enabled.

To set up the host or DNS table, complete the following steps. Make sure that the
host names for the controller match the IP addresses for the controllers.

1. Update either the host table or the DNS table to specify a host name to
associate with an IP address. If you do not have a DNS table, edit the host
table that is in the /etc/hosts file. Your directory might be different if the
operating system is not installed on the root.

2. To manage storage subsystems through a firewall, configure the firewall to open
port 2463 to TCP data.

3. Attempt to ping one of the controllers that are listed in the /etc/hosts file.

The following example shows a Linux host file.

# Do not remove the following line, or various programs
# that require network functionality will fail.

127.0.0.1 rh71_8500 localhost.localdomain
102.54.94.97 rhino.acme.com x.acme.com

Chapter 2. Preparing for installation 21



22 DS3000 Storage Manager Installation and Support Guide for AIX and Linux on POWER



Chapter 3. Installing and configuring the Storage Manager
software on AIX host systems

This chapter describes how to install the Storage Manager software in an AlX
operating-system environment.

Hardware and software requirements for the AIX host system

This section provides information about the hardware and software requirements for
the AIX host system.

Note: For the latest installation requirements and user information about the
Storage Manager software, AlX file sets, and hardware components, see the
Storage Manager readme file for AIX that is on the System Storage DS3000
Support Software for AIX CD (AIX host kit support CD).

Hardware requirements
The following minimum hardware is required.

Note: For the most current host support information, see the latest DS3000
interoperability matrix.

DS3400 support:

+ Any IBM System p or POWER server using the IBM POWER4™, POWERS5", or
POWER6™ 64-bit PowerPC architecture that supports one of the following Fibre
Channel host bus adapters:

- FC 6239

- FC 5716 /1957 / 1977
— FC 5758 /1905

- FC 5759/1910

- FC 5773

- FC 5774

IBM @server BladeCenter JS20 and IBM BladeCenter JS21, using the IBM
@server BladeCenter Fibre Channel expansion cards

Software requirements
The following operating system software is supported:
* AIX 5.2
The operating system must be at version 5200-10-02-0730 or later.
* AIX 5.3
The operating system must be at version 5300-06-02-0727 or later.

Note: The required minimum APARS are listed in the Storage Manager software
readme file for AIX.
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AIX restrictions

The following restrictions apply to AlIX configurations:

SAN and connectivity restrictions

* AIX hosts can support multiple host bus adapters (HBAs) and DS3000

devices; however, there is a restriction on the number of HBAs that can
be connected to a single DS3000 storage subsystem. You can configure
up to two HBAs per partition and up to two partitions per DS3000 storage
subsystem. You can add HBAs for additional DS3000 storage
subsystems and other SAN devices, up to the limits of your specific
storage subsystem platform.

AIX has the following limitations on disk volume sizes:
— 1 TB, on 32-bit AIX version 5.2

— 2 ZB, on 64-bit AIX version 5.2 (2 TB when using LVM bad block
relocation)

Where larger volumes are supported, the AlX boot logical volume must
reside within the first 2 TB of the volume. Hardware devices or vendor
software might further limit volume sizes. For more information, contact
your hardware or software vendor.

Direct-attach configurations are restricted to single-initiator configurations
only.

Single-switch configurations are supported, but each HBA and DS3000
controller combination must be in a separate SAN zone.

Other storage devices, such as tape devices or other disk storage, must
be connected through separate HBAs and SAN zones.

Restrictions when starting the system

» If you want to use a CD to install AIX on a DS3000 device on a partition

with more than 32 LUNs, you must use a CD that installs AIX version 5.2
or later. You cannot use an AIX CD that installs an earlier version of AlX.

When you start the system from a DS3000 device, both paths to the
DS3000 storage subsystem must be up and running.

The system cannot use path failover during the AIX startup process. After
the AIX host is started, failover operates normally.

For the best performance, do not start the system from a SATA device.

Partitioning restrictions

* The maximum number of partitions per AIX host, per DS3000 storage

subsystem, is three.

» All logical drives that are configured for AIX must be mapped to the AIX

host group (not AIX with Veritas DMP).

Note: If you are using the default host group, make sure that the default
host type is AlX.
For more information, see[‘Configuring host access” on page 83.|

On each controller, you must configure at least one LUN with an ID
between 0 and 31 that is not a UTM or access logical drive.
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Installing the DS3000 Storage Manager software

This section describes the procedures for installing the Storage Manager software.

Preparing for software installation

Before you install the Storage Manager software, make sure that you have the

following items:

» For the AIX operating system, make sure that you are running the operating
system-required maintenance level. (See the readme file for the lists of required
maintenance levels and additional fixes.)

* HBA device drivers

* The most up-to-date controller firmware for your particular storage subsystem,
but at a minimum the following firmware and NVSRAM versions are required:

DS3400:
Controller firmware: 06.70.22.00
Controller NVSRAM: N1726D34LR270V05 (single controller)

N1726D340R270V05 (dual controller)
» |IP addresses for the RAID controllers (for out-of-band management only)
» Additional documentation for switches and HBAs, if needed

» Applicable host software kit. The host software kit grants you permission to
attach host servers using the applicable operating system for the DS3000
storage subsystem. The kit includes the most up-to-date DS3000 software and
controller firmware for your particular storage subsystem.

» AIX host kit support CD, which includes the most up-to-date DS3000 software
and controller firmware for your particular storage subsystem

For the latest controller firmware, see |http://www.ibm.com/servers/eserver/|

support/fixes

Failover drivers

An AIX host system requires the AIX multipath I/O (MPIO) failover driver for path
redundancy. The failover driver monitors I/O paths. If a component failure occurs in
one of the 1/O paths, the failover driver reroutes all I/O to another path.

Note: The AIX MPIO driver files are not included on the AIX host kit support CD.
To install them, you must download the files from |http://www.ibm.com/|

lsystems/support/

Make sure that the AIX device driver that supports the DS3400 is installed. The
Multi Path 1/O driver (MPIO) is the driver that is required to run the DS3400 on AIX
systems. Verify that the driver is installed by typing the following command:

1sTpp -i devices.common.IBM.mpio.rte

If the device driver is not installed, the command returns "Fileset
devices.common.IBM.mpio not installed.” Obtain the required AlX installation media
and use the AIX SMIT utility to install the MPIO package. After the installation of the
MPIO package, make sure that the operating system version still reports the
required operating system version using the oslevel -s command.

Preparing for a SAN attachment

AIX supports either a direct-attached or a SAN-attached configuration to the
DS3400 storage subsystem.

Chapter 3. Installing and configuring the Storage Manager software on AIX host systems 25


http://www.ibm.com/servers/eserver/support/fixes/
http://www.ibm.com/servers/eserver/support/fixes/
http://www.ibm.com/systems/support/
http://www.ibm.com/systems/support/

The AIX failover driver that supports the DS3400 is the Multi Path I/O driver (MPIO).
The MPIO driver provides flexibility in the connectivity methods that can be used
when connecting supported devices.

The best practice is to use 2 to 4 adapters providing 4 to 8 paths.

The following examples are a small subset of the connectivity configurations that
are supported using the DS3400. For more configuration examples, see the section
“Connecting hosts to the DS3400” in the IBM System Storage DS3400 Storage
Subsystem Installation, User’s, and Maintenance Guide.

Attention: If a path fails in a single host bus adapter configuration, a loss of data
access can occur.

Example 1
Create one zone that contains two Fibre Channel HBA ports, one Fibre Channel
port from controller A and one Fibre Channel port from controller B of the DS3400.

This configuration provides four paths to hdisks. Two of the paths that are
associated with the preferred storage controller will service I/0Os when the DS3400
is Optimal. The other two paths are used if the preferred controller is not accessible
by the host.

Note: The hdisk attribute “algorithm” should be set to round_robin. If the attribute is
set to round_robin, the hdisk attribute “reserve_policy” must be set to
no_reserve, pr_exclusive, or pr_shared.

Example 2

Create separate zones for the connection between the HBA port and one port of the
DS3400 controller. Two zones are required for a dual-controller storage
configuration. One zone contains an HBA port and controller port from controller A.
The other zone contains a different HBA port and controller port from controller B.

This configuration provides two paths to hdisks.

Note: Attributes “algorithm” and “algorithm of hdisks” do not need to be altered
from default values.

Example 3
Create one zone that contains two Fibre Channel HBA ports and all four Fibre
Channel ports from the DS3400.

This configuration provides eight paths to hdisks. Four of the paths that are
associated with the preferred storage controller will service I/0Os when the DS3400
is Optimal. The other four paths are used if the preferred controller is inoperable.

Notes:

1. The hdisk attribute "algorithm” should be set to round_robin. When this attribute
is set to round_robin the hdisk attribute "reserve_policy” must be set to
no_reserve, pr_exclusive, or pr_shared.

2. Single host bus adapter configurations are allowed. If you have a single host
bus adapter in a SAN-attached configuration, the controller must have a Fibre
Channel connection to the host bus adapter through a switch, and both
controllers must be within the same SAN zone as the host bus adapter for
dual-controller storage configurations.
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Installing the Storage Manager software using the installation wizard

The DS3000 Storage Manager software installation wizard installs the following
software packages on the AIX host:

e SMruntime
* SMclient
* SMagent
o SMutil

Requirements
+ DS3000 Storage Manager version 02.70, or later
» Xxservices must be operational

If you are installing Storage Manager 02.70, or if your system does not have a
graphics card installed, or if for any reason you do not want to use the wizard to
install the software, skip this section and install the stand-alone host software
packages using the procedures described in [‘Installing the Storage Manager|
lsoftware in console mode.’]

Note: If you use the wizard to install the Storage Manager software, you might
need to increase the size of some partitions to accommodate the installation.

To install the DS3000 Storage Manager software using the installation wizard,
complete the following steps. Adjust the steps as necessary for your specific
installation.

1. Copy the following file from the AIX host kit support CD or download the file
from the DS3000 support Web site, to a directory on your system:

SMIA-AIX-02.70.xx.xx.bin

2. Open the file on your system. The Storage Manager Installation wizard
Introduction window opens.

3. Follow the instructions in each window of the wizard. When you select the
installation type, you can choose one of the following options:

« Typical (Full) Installation—Installs all Storage Manager software packages
* Management Station—Installs SMruntime and SMclient

* Host—Installs SMruntime, SMagent and SMutil

» Custom—Allows you to select which packages you want to install

Note: During the installation, you will see the question Automatically Start
Monitor? This refers to the Event Monitor service. If you want to enable
automatic ESM firmware synchronization, the Event Monitor must be
enabled. To enable the Event Monitor, select Automatically Start
Monitor.

The DS3000 Storage Manager software is installed on the system.

Installing the Storage Manager software in console mode

To install the Storage Manager software without the graphical interface, complete
the following steps:

1. From a command prompt, run the Storage Manager installation package while
using the - i console parameter to force the package to install in a non-graphical
mode. For Example, in Linux, the command is:

# sh SMIA-LINUXPPC-02.70.A5.15.bin — i console
2. Select the location (the default value is English) and press Enter.

Chapter 3. Installing and configuring the Storage Manager software on AIX host systems 27



3. Read the End User License Agreement (EULA). To continue, press Y (for Yes)
to accept the EULA.

4. Choose the installation type, and then press Enter:
» Typical
* Management Station
* Host
» Customize

5. Review the Pre-Installation Summary, and then press Enter. The installation is
completed.

6. Press Enter to exit the installer.

Configuring storage subsystems

If you have purchased a Storage Partitioning premium feature, make sure that the
premium feature is enabled. For more information, see|Chapter 7, “Enabling and
lusing premium features,” on page 105.|

To configure the Storage Manager software for an AlX system, complete the
procedures in the following sections. You can configure the Storage Manager
software from the Storage Manager client software running on either an AIX or a
non-AlX system.

Adding storage subsystems to the Storage Manager Client

To add storage subsystems to the Storage Manager Client (SMclient), complete the
following steps:

1. To set up the storage subsystem for AIX and SMclient, the storage subsystem
must be physically configured for direct management through the Ethernet
connections on each controller. Install SMclient before configuring the storage
subsystem.

Note: For information about assigning IP addresses to the controllers, see
[‘Step 3: Assigning IP addresses to hosts and controllers” on page 21
2. After the storage subsystem is configured on the network, start SMclient on the
host server by selecting the Storage Manager icon or by typing the following
command:

# /usr/SMclient/SMclient

The Enterprise Management window opens.
3. Complete the following steps to specify the IP addresses of the controllers:

a. In the Enterprise Management window, click Edit + Add Storage
Subsystem.

b. In the Add Storage Subsystem window, type the IP addresses of each
controller in the storage subsystem, and click Add. The name of the storage
subsystem is displayed in the Enterprise Management window.

Note: Failure to add both controllers results in a partially-managed system,
where all functions might not be available.

4. Double-click the name of the storage subsystem to open its Subsystem
Management window.
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Upgrading controller firmware and NVSRAM

For detailed procedures for downloading the firmware updates, see |“Downloadina
icontroller, NVSRAM, ESM, and hard disk drive firmware” on page 93.

Creating storage partitions

The procedures in this section assume that you have already created a physical
connection between the host and the storage subsystem controllers, and that you
have connected and zoned the SAN switch (if any). If you have not completed
these connections, the Storage Manager software is not able to list the WWPNs of
the HBAs during these procedures. In this case, you have to type the WWPNSs in
the applicable fields in the procedure for defining a host and host ports.

Recording the WWPN of the HBAs on a server

Type the following commands for each HBA port that you want to use for the
installation. This documents the WWPN that is displayed in the Storage Manager
Client during the host definition process.

Tscfg -vpl fcsX|grep Network
# 1scfg -vpl fcsO|grep Network

Network Address............. 10000000C94BC2A3

Record this information to use during the procedure for defining the host and host
port.

Running the cfgmgr command

Run the AIX command cfgmgr -v. This causes the HBA Fibre Channel ports to log
into the storage ports. This enables the Storage Manager software to display the
WWPN during the host definition process.

Defining the host and host port

To define the host and host ports by using the Configure Host Access wizard,
complete the following steps:

1. Select the Configure tab on the Subsystem Management window and select
one of the following methods:

* Create Host Access (Automatic)
» Create Host Access (Manual)

2. Select Create Host Access (Automatic) if you have added a new host that is
also running the host agent on the system. Otherwise go to step

3. If any host are automatically configured, they are displayed in the left column
as an Available Host. Select a host from the list of available hosts and click
Add.

4. After all the available hosts are moved to the Select Host column, click OK.
The host and host ports are defined and you have completed this procedure.

5. Select Create Host Access (Manual) to manually define the host and host
port information.

6. From the Specific Host Name and Host Type window, enter the host name and
then select AIX as the host type from the host type list. Click Next.

7. From the Specify HBA Host Port window, in the left pane, select the correct
WWPN of the HBA host port that will be used to define the host. Click Add.
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Note: If there is not a physical connection between the host and the DS3000
controllers, the WWPNSs are not displayed. In this case, you must
manually enter the correct WWPN information by completing the
following steps:

a. Click New.

b. Enter the Fibre Channel WWPN information.
c. Enter the host port alias.

d. Click Add.

After all the host ports are added to the Selected HBA host port column, click

Next.

From the Specify Host Group window, select one of the following options:

» Select No if the host will not share access to the same logical drive with

other hosts; then, click Next.

+ Select Yes if the host will share access to the same logical drive with other
hosts. Either enter a New Host Group name or select an existing host group
from the list; then, click Next.

10. Review the host definition details, and then click Finish.

Defining a host group

A host group is an entity in the Storage Partitioning topology that defines a logical
collection of host computers that require shared access to one or more logical
drives. You can grant individual hosts in a defined host group access to storage
partitions, independently of the host group.

To define a host group, complete the following steps:

1.
2.
3.

4.
5.

Click the Configure tab on the Subsystem Management window.
Select Create Host Group.

Enter the new host group name (for example, AlX) and select the hosts from the
left column. Click Add to add them to the host group.

When all the hosts for the host group are added, click OK.
A message is displayed indicating that the new host group is created. Click OK.

Mapping LUNs to a storage partition

This section contains the procedures for mapping and adding LUNs to a host or
host group. These steps can be used to map LUNs to a new partition or add LUNs
to an existing partition.

To map LUNs, complete the following steps:

1.
2.
3.

4.

Select the Configure tab on the Subsystem Management window.
Select Create Host-to-Logical Drive Mapping.

From the Select Host window, select the host or host group that the logical
drives will be mapped and click Next.

From the Select Logical Drives window, select the logical drives that will be
mapped to the host or host group that was selected in step .

Note: If all the logical drives will be mapped to the same host or host group,
then click the Select all logical drives check box.

After the logical drives are selected, assign a logical unit number (LUN) from 0
to 31, to the logical drives and click Finish.
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5. The Host-to-Logical Drive Mapping progress window is displayed. When the
mappings are completed, click OK.

6. The mappings are completed. Select Yes to map additional logical drives or No
to complete the mappings wizard.

Identifying devices on AIX hosts

The MPIO driver creates the following devices that represent the DS3000 storage
subsystem configuration, as shown in :

dac The disk array controller (dac) devices represent a controller within the
storage subsystem. Dac devices are only needed for in-band management.
If access LUNs are not mapped to the system partition through the Storage
Manager software, no dac devices are discovered.

hdisk Each hdisk device represents an individual logical drive on the AlX system.
Logical drives that are owned by the DS3000 storage subsystems can be
identified using the following command:

Isdev -Cc disk|grep DS3K

DS3400
(dar0)
Switch 0 LUNSs
hdisk1
hdisk3
hdisk5
|fcsO
= hdisk7
AIX Server
[fcsT e Switch 1
ez hdisk2
hdisk4
hdisk6

hdisk8

Preferred path
................... Fa”over path

Figure 6. DS3000 and AlX system configuration

Performing initial device discovery

Before you begin: Make sure that the DS3000 storage subsystem is set up
correctly, any applicable Fibre Channel switch zoning is complete, LUNs are
assigned to the host, and the AIX software and firmware requirements are met.

To perform the initial device discovery, complete the following steps:
1. Type the following command to probe for the new devices:
# cfgmgr -v

Note: In a SAN configuration, the devices do not log into the SAN switch until
you run the efgmgr command.
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2. Type the following command:

# 1sdev -Cc disk | grep DS3K

Examine the output of the Isdev -Cc disk | grep DS3K command to be sure
that the AIX MPIO software recognizes the correct number of DS3000 logical
drives.

The following example shows the output of the Isdev -Cc disk | grep DS3K
command for a set of DS3400 LUNSs:

# 1sdev -Cc disk|grep DS3K

hdisk3 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk4 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk5 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk6 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk7 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk8 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk9 Available 00-08-01 MPIO Other DS3K Array Disk

Verifying the installation and configuration

After you have performed the initial device identification, complete the following
procedures to verify that all of the DS3000 device names and paths are correct,
and that AlX recognizes the dars, dacs, and hdisks.

Using the mpio_get_config —Av command

Use the AIX mpio_get_config -Av command to perform the following verification
tasks:

1.

Correlate AIX hdisk numbers to the logical drive name displayed in the Storage
Manager Client.

Note: The logical drive name from the Storage Manager client is displayed
under the “User Label” heading.

Make sure that logical drives are on the preferred DS3400 controller (controller
A or B).

Make sure that the correct number of storage controllers are discovered:

Controller count: 1 (Indicates a single-controller configuration)

Controller count: 2 (Indicates a dual-controller configuration)

Make sure that the “Partition count” matches the number of storage partitions
configured to the system on the Storage Manager client.

The following example shows the output of the mpio_get_config —Av command
for a dual-controller DS3400 storage subsystem:
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# mpio_get_config -Av
Frame id 0:
Storage Subsystem worldwide name: 60ab800374244000047064e0
Controller count: 2
Partition count: 2
Partition 0:
Storage Subsystem Name = 'Accounting FEB'

hdisk LUN # Ownership User Label
hdisk35 0 B (preferred) E-1-S5
hdisk36 1 B (preferred) F-1-S5
hdisk37 2 B (preferred) G-1-S5
hdisk38 3 B (preferred) H-1-S5
hdisk39 4 A (preferred) E-2-S5
hdisk40 5 A (non-preferred) F-2-S5

Using the Ispath command
Use the Ispath command to verify the following information for each DS3400 hdisk:
1. Make sure that the expected number of paths are detected.
2. \Verify that the path status is Enabled.

The following example shows the output of the Ispath command for a
dual-controller DS3400 storage subsystem:

# 1spath|sort

Enabled hdiskl0 fscsil
Enabled hdiskl0 fscsil
Enabled hdiskl0 fscsi3
Enabled hdisk10 fscsi3
EnabTed hdiskll fscsil
Enabled hdiskll fscsil
Enabled hdiskll fscsi3
Enabled hdiskll fscsi3
Enabled hdiskl2 fscsil
Enabled hdiskl2 fscsil
Enabled hdiskl2 fscsi3
EnabTed hdiskl2 fscsi3

The Ispath command example shows that all paths are in the Enabled state
and that each hdisk has four paths.

Using the Isdev command

The Isdev command displays devices and their characteristics. The Isdev
command also shows the state of the devices at startup time, or the last time that
the cfgmgr -v command was run.

If you are using in-band management, make sure that the correct number of dac
devices are discovered by using the Isdev -Clgrep dac command on the AlX
system.

The following example shows the output of the Isdev -Clgrep dac command:

# 1sdev -C |grep dac
dacO Available 03-00-02 DS3/4K PCM User Interface
dacl Available 08-08-02 DS3/4K PCM User Interface
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This Isdev command example shows two dac devices. One dac device should be
detected for each controller in the DS3400 storage subsystem. Dac devices are
detected only if the access LUN is mapped to the storage partitions for this host
system.

Each dac has its own location code, or path, which is represented by the values
03-00-02 and 08-08-02. Each AIX system has its own set of location codes that
describe the internal path of that device, including bus and host-adapter locations.

See the service manual for your IBM System p server to identify device locations.

Using the Isattr command

The Isattr command displays device attributes and possible values. Attributes are
updated only at startup time, or the last time that the cfgmgr -v command was run.

Use the Isattr —El hdisk command to view the current attributes for each DS3000
associated hdisk. Make sure that the “algorithm” and “reserve_policy” attributes are
set to the intended values.

The following example shows the output of the Isattr —El hdisk30 command. In this
example, the current attributes of hdisk30 are shown:

1sattr -ET hdisk30

PCM PCM/friend/otherapdisk Path Control Module False
PR_key_value none 16 Bit LVD SCSI Disk Drive True
algorithm round_robin Algorithm True
clr_q no Device CLEARS its Queue on error True
cntl_delay_time 0 Controller Delay Time True
cntl1_hcheck_int 0 Controller Health Check Interval True
cntl_hcheck_int 0 Controller Health Check Interval True
dist_err_pcnt 0 Distributed Error Percentage True
dist_tw_width 50 Distributed Error Sample Time True
hcheck_cmd inquiry Health Check Command True
hcheck_interval 60 Health Check Interval True
hcheck_mode nonactive Health Check Mode True
location Location Label True
Tun_id 0x7000000000000 Logical Unit Number ID False
max_transfer 0x40000 Maximum TRANSFER Size True
node_name 0x200800a0b824581a FC Node Name False
pvid 000c27fe9a2184350000000000000000 Physical volume identifier False
g_err yes Use QERR bit True
q_type simple Queuing TYPE True
queue_depth 4 Queue DEPTH True
reassign_to 120 REASSIGN time out value True
reserve_policy no_reserve Reserve Policy True
rw_timeout 30 READ/WRITE time out value True
scsi_id 0x7a0700 SCST ID False
start_timeout 60 START unit time out value True
ww_name 0x203800a0b824581a FC World Wide Name False

Changing the "algorithm" and "reserve_policy" attributes

To correctly use the planned configuration, the algorithm and reserve_policy
attributes need to be set correctly.

Using example 1 in|“Preparing for a SAN attachment” on page 25,| if attribute
“algorithm” is not changed to round_robin, only one of the HBAs is used until the
first HBA fails. After the first HBA has failed, the second HBA will service the I/Os. If
the “algorithm” is set to round_robin, the I/Os will alternate between the two HBAs.
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Note: Use the chdev command to change the attributes.

For example, to change the attributes of the algorithm to round_robin and the
reserve_policy to no_reserve for hdisk30, the command is:

# chdev -1 hdisk30 -a algorithm=round_robin —a reserve_policy=no_reserve

Viewing and setting Object Data Manager (ODM) attributes

Some of the Object Data Manager (ODM) attributes are for information purposes
only. These information-only attributes show how the DS3000 storage subsystem is
configured or its current state. You can modify other attributes using SMIT or by
using the AIX chdev -p command.

Attribute definitions

The following tables list definitions and values of the ODM attributes for dars, dacs

and hdisks:

« [Table 9 Attributes for dar devices

« [Table 10 on page 37} Attributes for dac devices

« [Table 11 on page 38} Attributes for hdisk devices

Notes:

1. Attributes with True in the Changeable column can be modified from their

default settings.

2. Attributes with False in the Changeable column are for informational or state
purposes only. However, some attributes with False in the Changeable column
can be modified using the DS3000 Storage Manager software.

3. The Isattr -El (uppercase E, lowercase L) command is another way to
determine which attributes can be modified. Attributes that can be modified
display True in the last column of the Isattr -El output. You can also display the
default values by using the Isattr -DI command. See [‘Using the Isattr command|

[to view ODM attributes” on page 41| for more information.

Table 9. Attributes for dar devices

Attribute

Definition

Changeable (T/F)

Possible value

act_controller

List of controllers in
the active state at the
time of configuration.

False

Set at configuration
time by the RDAC
software.

all_controller List of controllers that | False Set at configuration
comprise this array; time by the RDAC
usually there are two software.
dac devices.

held_in_reset Name of the controller | True Set at configuration

that was in the
held-in-reset state at
the time of
configuration, or none
if no controllers were
in that state.

time by the RDAC
software. Should not
be changed.
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Table 9. Attributes for dar devices (continued)

Attribute

Definition

Changeable (T/F)

Possible value

load_balancing

Indicator that shows
whether load
balancing is enabled
(yes) or disabled
(no); see the
definition of the
balance_freq attribute
for more information.

True

Yes or No.
Attention: You
should only set the
load_balancing
attribute to yes in
single-host
configurations.

autorecovery

Indicator that shows
whether the device
returns the array to
dual-active mode
when it detects proper
operation of both
paths and controllers
(yes) or not (no).

True

Yes or No. See
restrictions on use.

hithchk_freq

Number that specifies
how often health
checks are
performed, in
seconds.

True

1 - 9999. Should not
be changed

aen_freq

Number that specifies
how often polled AEN
checks are
performed, in
seconds.

True

1 - 9999. Should not
be changed

balance_freq

If load_balancing is
enabled, number that
specifies how often
the system performs
load-balancing on the
array, in seconds.

True

1 - 9999 - should not
be changed

fast_write_ok

Indicator that shows
whether fast-write
write-caching is
available for this
system (yes) or not
(no).

False

Yes or No. State of
DS3000 configuration.

cache_size

Cache size for both
controllers, in

megabytes; 0 if the
sizes do not match.

False

512 or 1024. Set by
DS3000.
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Table 9. Attributes for dar devices (continued)

Attribute

Definition

Changeable (T/F)

Possible value

switch_retries

Number that specifies
how many times to
retry failed switches,
in integers.

True

0 - 255.
Default: 5

For most
configurations, the
default is the best
setting. If you are
High Availability
Cluster
Multi-Processing
using (HACMP™), it
can be helpful to set
the value to 0.
Important: You
cannot use
concurrent firmware
download if you
change the default
setting.

Table 10. Attributes for

dac devices

Attribute

Definition

Changeable (T/F)

Possible value

passive_control

Indicator that shows
whether this controller
was in passive state
at the time of
configuration (yes) or
not (no).

False

Yes or No. State of
DS3000 configuration.

alt_held_reset Indicator that shows | False Yes or No. State of
whether the alternate DS3000 configuration.
controller was in the
held-in-reset state at
the time of
configuration (yes) or
not (no).

controller_SN Serial number of this |False Set by DS3000.
controller.

ctrl_type Type of array this False 1726-2xx, 1726-3xX,
controller belongs to. 1726-4xx. Set by
A value of 1726-2xx DS3000.
indicates DS3200; a
value of 1726-3xx
indicates DS3300; a
value of 1726-4xx
indicates DS3400.

cache_size Cache size of this False 512, 1024. Set by
controller, in DS3000.
megabytes.

scsi_id SCSI identifier of this |False Set by SAN, reported
controller. by AIX.

lun_id Logical unit number of | False Set by DS3000.

this controller.
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Table 10. Attributes for dac devices (continued)

Attribute Definition Changeable (T/F) Possible value

utm_lun_id Logical unit number of | False 0 - 31. Set by
this controller, or DS3000 Storage
none if UTM (access Manager.
logical drives) is not
enabled.

node_name Name of the Fibre False Set by DS3000
Channel node.

location User-defined location |True Set by DS3000
label for this Storage Manager.
controller; the system
does not use this
value.

ww_name Fibre Channel False Set by DS3000.
worldwide name of
this controller.

GLM_type GLM type used for False High or Low. Set by

this controller.

DS3000.

Table 11. Attributes for hdisk devices

Attribute Definition Changeable (T/F) Possible value

pvid AIX physical volume | False Set by AIX.
identifier, or none if
not set.

q_type Queueing type for this | False Set by AIX. Must be
device; must be set to “simple”.
simple.

queue_depth Number that specifies | True 1-64
the depth of the Note: See |“Setting|
queue based on the queue depth for
system configuration; hdisk devices” on|
reduce this number if page 40| for important
the array is returning information about
a BUSY status on a setting this attribute.
consistent basis.

PR_key_value Required only if the True 1-64, or None.
device supports any Note: You must set
of the persistent this attribute to
reserve policies. This non-zero before the
attribute is used to reserve_policy
distinguish between attribute is set.
different hosts.

reserve_policy Persistent reserve True no_reserve
policy, which defines PR_shared,
whether a reservation PR_exclusive, or
methodology is single_path

employed when the
device is opened.
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Table 11. Attributes for hdisk devices (continued)

Attribute

Definition

Changeable (T/F)

Possible value

max_transfer

Maximum transfer
size is the largest
transfer size that can
be used in sending
1/0.

True

Numeric value;
Default = 1 MB
Note: Usually
unnecessary to
change default,
unless very large I/Os
require increasing the
value.

write_cache Indicator that shows |False Yes or No.
whether write-caching
is enabled on this
device (yes) or not
(no); see the
definition of the
cache_method
attribute for more
information.

size Size of this logical False Set by DS3000.
drive.

raid_level Number that specifies | False 0, 1, 3, 5. Set by
the RAID level of this DS3000 Storage
device. Manager.

rw_timeout Number that specifies | True 30 - 180. Should not
the read/write timeout be changed from
value for each default.
read/write command
to this array, in
seconds; usually set
to 30.

reassign_to Number that specifies | True 0 - 1000. Should not
the timeout value for be changed from
FC reassign default.
operations, in
seconds; usually set
to 120.

scsi_id SCSI identifier at the |False Set by SAN, reported
time of configuration. by AIX.

lun_id Logical unit number of | False 0 - 255. Set by
this device. DS3000 Storage

Manager.
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Table 11. Attributes for hdisk devices (continued)

Attribute Definition Changeable (T/F) Possible value

cache_method If write_cache is False Default, fast_write,
enabled, the fast_load, fw_unavail,
write-caching method fl_unavail.

of this array; set to
one of the following:

* default. Default
mode; the word
"default” is not
seen if write_cache
is set to yes.

» fast_write.
Fast-write
(battery-backed,
mirrored
write-cache) mode.

¢ fw_unavail.
Fast-write mode
was specified but
could not be
enabled;
write-caching is not
in use.

» fast_load.
Fast-load
(non-battery-
backed,
non-mirrored
write-cache) mode.

¢ fl_unavail.
Fast-load mode
was specified but
could not be
enabled.

prefetch_mult Number of blocks to False 0 - 100.
be prefetched into
read cache for each
block read.

ieee_volname IEEE unique logical False Set by DS3000.
drive name identifier
for this logical drive.

Setting the queue depth for hdisk devices

Setting the queue_depth attribute to the applicable value is important for system
performance. If you have a large DS3000 configuration with many logical drives and
hosts attached, use this setting for high performance.

This section provides methods for calculating the maximum queue depth for the
system, which you can use as a guideline to help you determine the best queue
depth setting for your configuration.

Calculating the maximum queue depth: For DS3000 storage subsystems, use
the following formula to determine the maximum queue depth:

2048 / (number-of-hosts x LUNs-per-host)
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For example, a system with four hosts, each with 32 LUNs, has a maximum queue
depth of 16:

2048/ (4x32)=16

Setting the queue depth attribute: You can set the queue_depth attribute using
the chdev - command, as shown in the following example:

# chdev -1 hdiskx -a queue_depth=y
where x is the name of the hdisk and y is the queue depth setting.

Note: Use the -P flag to make the changes permanent in the Customized Devices
object class.

Using the Isattr command to view ODM attributes

To view the Object Data Manager (ODM) attribute settings for fcs, fscsi, dacs, and
hdisks, use the Isattr command to perform the following tasks::

» To view the default settings, type Tsattr -D1.
» To view the attributes that are currently set on the system, type 1sattr -E1.

The following example displays the attributes for the fcs device.

# lsattr -ET fcsO

bus_intr_1vl 305 Bus interrupt Tevel False
bus_io_addr  Oxff800 Bus I/0 address False
bus_mem_addr Oxfff7e000 Bus memory address False
init_Tink al INIT Link flags True
intr_priority 3 Interrupt priority False
1g_term_dma  0x800000  Long term DMA True
max_xfer_size 0x100000 Maximum Transfer Size True
num_cmd_elems 200 Maximum number of COMMANDS to queue to the adapter True
pref_alpa 0x1 Preferred AL_PA True
sw_fc_class 2 FC Class for Fabric True

The following example displays the attributes for the fscsi device.

# lsattr -ET fscsiO

attach switch How this adapter is CONNECTED False
dyntrk no Dynamic Tracking of FC Devices True
fc_err_recov delayed fail FC Fabric Event Error RECOVERY Policy True
scsi_id 0x7c0e00 Adapter SCSI ID False
sw_fc_class 3 FC Class for Fabric True

The following example displays the attributes for the dac device.

# 1sattr -E1 dacO

PCM PCM/friend/ds4k-ui Path Control Module False
Tun_id 0x1f000000000000  Logical Unit Number ID False
node_name 0x200400a0b83743b1 FC Node Name False
scsi_id  Oxef SCSI 1D False

ww_name  0x202400a0b83743b1 FC World Wide Name False
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The following example displays the attributes for the hdisk device

# 1sattr -E1 hdisk24

PCM PCM/friend/otherapdisk Path Control Module False
PR_key_value none 16 Bit LVD SCSI Disk Drive True
algorithm round_robin Algorithm True
clr_q no Device CLEARS its Queue on error True
cnt]l_delay time 0 Controller Delay Time True
cntl1_hcheck_int 0 Controller Health Check Interval True
cntl_hcheck_int 0 Controller Health Check Interval True
dist_err_pcnt 0 Distributed Error Percentage True
dist_tw_width 50 Distributed Error Sample Time True
hcheck_cmd inquiry Health Check Command True
hcheck_interval 60 Health Check Interval True
hcheck_mode nonactive Health Check Mode True
location Location Label True
Tun_id 0x1000000000000 Logical Unit Number ID False
max_transfer 0x40000 Maximum TRANSFER Size True
node_name 0x200800a0b824581a FC Node Name False
pvid none Physical volume identifier False
g_err yes Use QERR bit True
q_type simple Queuing TYPE True
queue_depth 4 Queue DEPTH True
reassign_to 120 REASSIGN time out value True
reserve_policy no_reserve Reserve Policy True
rw_timeout 30 READ/WRITE time out value True
scsi_id 0x7a0700 SCST ID False
start_timeout 60 START unit time out value True
ww_name 0x203800a0b824581a FC World Wide Name False

Viewing the capacity of hdisk

The bosinfo -s <hdisk#> command can be used to display the current capacity of
the hdisk. By default, the capacity is displayed in megabytes. The bootinfo -s
command displays the updated capacity after a Dynamic Volume Expansion
operation.

Additional AIX configuration information

The following sections describe additional AIX configuration information.

Using fast I/O failure for Fibre Channel devices

I/0 failover occurs when a Fibre Channel adapter device driver detects a link failure
on the fabric between the switch and the DS3000 storage subsystem. You can
change the failover characteristics by setting the fscsi device attribute fc_err_recov
to one of the following settings.

fast_fail Enables fast 1/0 failure.

If the Fibre Channel adapter device driver detects that a link was
lost between the switch and the DS3000 storage subsystem, it
waits a few seconds to enable the fabric to stabilize. If fast_fail is
specified, the adapter then begins failing all I/O at the adapter
device driver if it detects that the device is not on the fabric. Any
new /O or future retries of the failed 1/0 are failed immediately.

Fast 1/O failure can be useful in multipath configurations. It can
decrease the I/O fail times due to the loss of a link between the
storage device and the switch, and can enable faster failover to
alternate paths.
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delayed_fail Default setting.

If delayed_fail is specified, 1/O failure proceeds as normal; retries
are not immediately failed, and failover takes longer than it does if
fast_fail is specified.

In single-path configurations, especially configurations with a single
path to a paging device, the delayed_fail setting should be used.

Example: You can enable fast I/O failure by setting this attribute, as shown in the
following example. Be sure to stop all /O and put the fscsi device into a Defined
state before you set the attribute.

chdev -1 fscsi0 -a fc_err_recov=fast_fail

Notes:
1. The fast_fail attribute only affects failover that occurs between the switch and

the DS3000 storage subsystem. It does not affect failover that occurs between
the host and the switch.

2. Set the fast_fail attribute on each HBA that is configured to the DS3000 storage
subsystem.

3. You can use fast I/O failure only in a SAN environment. You cannot use it in a
direct-attach environment.

Using dynamic tracking of Fibre Channel devices

AIX dynamically tracks Fibre Channel devices when they are moved from one Fibre
Channel port on a switch to another port. This enables the dynamic movement of a
Fibre Channel connection by suspending I/O for 15 seconds while the move occurs.
If a cable move is completed in less than 15 seconds, this feature prevents the
logical drives from being moved off the preferred path.

You can enable or disable dynamic tracking by setting the fscsi device attribute
dyntrk to one of the following settings:

yes Enables dynamic tracking.

If dynamic tracking is enabled, the Fibre Channel adapter detects when the
Fibre Channel node port ID of a device changes. It reroutes the traffic that
is intended for that device to the new worldwide port name (WWPN) while
the devices are still online.

For example, you can move a cable from one switch port to another while
the devices are still online, and no failover occurs if you complete the move
within 15 seconds. After 15 seconds, failover occurs.

Tip: The ports must be in the same zone on the same switch.

no Default setting.
If dynamic tracking is not enabled, you must take the devices offline before
you move a cable from one port to another. Otherwise, failover occurs.

Example: You can enable dynamic tracking by setting this attribute, as shown in
the following example. Be sure to stop all I/O and put the fscsi device into a
Defined state before you set the attribute.

chdev -1 fscsi0 -a dyntrk=yes
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Notes:

1. Set the dyntrk attribute on each HBA that is configured to the DS3000 storage
subsystem.

2. You can use dynamic tracking only in a SAN environment. You cannot use it in
a direct-attach environment.

Using dynamic capacity expansion and dynamic volume expansion

Dynamic volume expansion (DVE) is dynamic on the DS3000 storage subsystem,
but it requires manual intervention for AlX to recognize the new logical drive
capacity. This section explains how to use DVE with AlX.

Before you begin: Make sure that there is sufficient available free capacity within
the array. Free capacity can be determined using the DS3000 Storage Manager
software. In the Summary/Arrays & Logical Drives view of the Subsystem
Management window, expand the desired array and scroll to the bottom of the
logical drives list. Available free capacity is an entry in the logical drives list.

If there is insufficient free capacity and extra drives are available, perform a
dynamic capacity expansion (DCE) operation before performing the DVE operation.
A DCE operation increases the capacity of the array by adding unused physical
disks that are already installed in the drive enclosures.

Performing a dynamic capacity expansion operation

To perform a dynamic capacity expansion operation, complete the following steps:

1. In the Modify/Add Free Capacity (Drives) view, select the array whose capacity
is to be increased.

2. Select Next.

3. Select an available drive in the “Add capacity to array” window.

4. Select Finish.

Note: The available free disks and their capacity are displayed in the window.

After the operation is started, a clock is displayed beside every logical drive in the
array and remains until the operation is completed. The process might take several
hours and must be allowed to complete before AIX intervention.

Note: The time required for the operation to be completed depends on the 1/0
activity, capacity being added, drive technology, and other factors.

Performing a dynamic volume expansion operation

Performing a dynamic volume expansion requires the functionality of the Storage
Manager software SMcli interface or the Storage Manager software script editor.
The following example shows the command syntax that is required to run the
dynamic volume expansion from the script editor window on a logical drive named
Engineering_FEB. The capacity added is 1 GB.

set logicalDrive ["Engineering FEB"] addCapacity=1GB;

Note: After the operation is completed, you can view the new capacity on the AIX
system by using the bootinfo —s hdiskX command.

To perform a DVE on the AIX host, complete the following steps. For more

information about expanding Logical VolumeManager (LVM) logical drives, see the
man page for the chvg command.
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1. Unmount the file systems from the LVM logical drive group that is expanded, by
typing the following command:

umount mount_point

where mount_point is the name of the file system that is being unmounted.
2. Change the logical drive group by typing the following command:
chvg -g logical_drive_group_name

where the logical_drive_group_name is the name of the associated LVM logical
drive group.

Note: If you see a warning message that the logical drive group cannot be
imported to AIX 5.1 or earlier, ignore the warning message. The error
message is incorrect.

3. Mount the file systems.

Notes:

1. You might have to run the varyoffvg command, and then the varyonvg
command, on the logical drive group for LVM to see the size change on the
disk. However, the new capacity is available for use by the operating system.

2. You cannot resize the logical drive while the logical drive group is activated in
classic or enhanced concurrent mode.

3. You cannot resize the root logical drive group.

Replacing hot-swap HBAs

This section describes the procedure for hot-swapping Fibre Channel host bus
adapters (HBAs) on an AlX host.

The hot swap procedure requires knowledge in the following areas:
* AIX administration

* AIX hardware procedures for PCI adapter replacement

+ DS3000 Storage Manager software

» Fibre Channel zoning procedures (required if a switch is used to interconnect
DS3000 storage subsystems and the AIX host, and zoning is based on WWPN)

Attention: If the procedures are not followed as they are documented in this
section, loss of data availability can occur. Make sure that you read and understand
all of the requirements and steps in this section before you begin the HBA hot-swap
procedure.

Known issues and restrictions

Before you perform a hot-swap operation, read the following known issues and
restrictions:

Attention: Any deviations from these notes and procedures might cause a loss of
data availability.

* You must replace a defective HBA with the same model HBA, and install it in the
same PCI slot.

Do not insert the defective HBA into any other system, even if the HBA is later
found to not actually be defective. Always return the HBA to IBM.

Important: No other variations of replacement scenarios are currently supported.
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» Hot-swapping an HBA is not supported if the replacement of the HBA will remove
the last viable path to any hdisk.

Collecting system data
To collect data from the system, complete the following steps:
1. Type the following command:
# 1sdev -C |grep fcs

The output is similar to the following example:

fcso Available 17-08 FC Adapter
fcsl Available 1A-08 FC Adapter

2. Type the following command:
# 1sdev -C |grep dac

The output is similar to the following example:

# 1sdev -C |grep dac
dacO Available 00-08-01 DS3/4K PCM User Interface
dacl Available 00-08-01 DS3/4K PCM User Interface

3. Type the following command for each of the fcs devices:
# 1scfg -vpl fcsx

where x is the number of the fcs device. The output is similar to the following
example:
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1scfg -vpl fcsO
fcso U0.1-P1-11/Q1 FC Adapter
Part Number................. 09P5079
EC Level.veeeeennninennnnnn. A
Serial Number............... 1€21908D10
Manufacturer................ 001C
Feature Code/Marketing ID...2765
FRU Number.........ccoeuen.. 09P5080
Network Address............. 10000000C92D2981
ROS Level and ID............ 02€03951
Device Specific.(Z0)........ 2002606D
Device Specific.(Z1)........ 00000000
Device Specific.(Z2)........ 00000000
Device Specific.(Z3)........ 03000909
Device Specific.(Z4)........ FF401210
Device Specific.(Z5)........ 02C03951
Device Specific.(Z6)........ 06433951
Device Specific.(Z7)........ 07433951
Device Specific.(Z8)........ 20000000C92D2981
Device Specific.(Z9)........ CS3.91A1
Device Specific.(ZA)........ C1D3.91A1
Device Specific.(ZB)........ C2D3.91A1
Device Specific.(YL)........ U0.1-P1-11/Q1
PLATFORM SPECIFIC

Name: fibre-channel

Model: LP9002

Node: fibre-channel@l

Device Type: fcp

Physical Location: U0.1-P1-11/Q1

Replacing the hot-swap HBA

After you complete the procedures in [‘Collecting system data” on page 46|
complete the following steps to replace the hot swap HBA:

1. Place the HBA that you want to replace into the Defined state by typing the
following command:

# rmdev -R1 fcsx

where x is the number of the HBA. The output is similar to the following
example:

rmdev -R1 fcs0O
fcnet0 Defined
dacO Defined
fscsiO Defined
fcsO Defined

2. In the AIX SMIT menu, initiate the process that is required to hot-swap the
HBA by selecting smit » Devices » PCI Hot Plug Manager »
Replace/Remove a PCI Hot Plug Adapter.

3. In the Replace/Remove a PCI Hot Plug Adapter window, select the targeted
HBA. A window opens that contains instructions for replacing the HBA.

4. Replace the HBA by following the SMIT instructions.
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10.

11.

Note: Do not reinstall the Fibre Channel cable at this time.

If steps [1 on page 47|to 4 on page 47|in this procedure are completed
successfully, make sure that you have the following results:

* The defective HBA is removed from the system.

* The replacement Fibre Channel HBA is powered on.

» The associated fcsx device is in the Defined state.

Install the Fibre Channel loop back on the replacement HBA.

Place the HBA into the Active state by typing the following command:

# cfgmgr

Verify that the fcs device is now available by typing the following command:
# 1sdev -C |grep fcs

Verify or upgrade the firmware on the replacement HBA to the applicable level
by typing the following command:

# 1scfg -vpl fecsx

where x is the number of the fcs.

Note: You can determine the HBA firmware level by referring to the fcsx
device data that you gathered during the procedure at the start of this
section, [‘Collecting system data” on page 46.|

Record the 16-digit number that is associated with Network Address, as it was
displayed in the output of the command you used in step@ This Network
Address number is used in the next procedure to manually map the
replacement HBA WWPN to the storage subsystems.

Place the HBA back into the Defined state by typing the following command:

# rmdev -R1 fcsX

When you have completed this procedure, continue to the next procedure,

[‘Mapping the new WWPN to the DS3000 storage subsystem.’]

Mapping the new WWPN to the DS3000 storage subsystem

For each DS3000 storage subsystem that is affected by the hot-swap procedure, to
map the worldwide port name (WWPN) of the new HBA to the storage subsystem,
complete the following steps:

1.

w

Start the DS3000 Storage Manager software and open the Subsystem
Management window.

In the Subsystem Management window, select the Modify tab.
Locate the defective HBA, select HBA, and then click Replace HBA.

Locate the new HBA WWPN from the list, modify the alias, if you want, and
then click OK to activate the change.

Completing the HBA hot-swap procedure

To finish replacing the hot-swap HBA, complete the following steps:

1.

Remove the Fibre Channel loop-back plug and insert the Fibre Channel cable
that was previously attached to the HBA that you removed.

If the HBA is attached to a Fibre Channel switch, and the zoning is based on
the WWPN, modify the zoning information to replace the WWPN of the removed
HBA with the WWPN of the replacement HBA. (Run the cfgmgr command at
this time to enable the HBA to register its WWPN in the Fibre Channel switch.)
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Important: Skip this step if the HBA is directly attached to the DS3000 storage
subsystem, or if the Fibre Channel switch zoning is based on port
numbers instead of WWPNSs. If you need to modify the zoning,
failure to correctly do so prevents the HBA from accessing the
storage subsystem.

3. Run the efgmgr command.

4. Use the Isdev —C command to verify that the replaced fcsx device and its
associated dacs are placed in the Available state. See the output from the
following example:

# 1sdev -C |grep fcs

fcs0 Available 00-08 FC Adapter
fcsl Available 00-09 FC Adapter
fcs2 Available 05-08 FC Adapter
fcs3 Available 05-09 FC Adapter

5. Using the Storage Manager Client, manually redistribute the logical drives to the
preferred paths unless the autorecovery attribute for the hdisks is set to Yes.

The autorecovery functionality starts redistributing drives that are not on the
preferred path after the link health is detected as Healthy for 5 minutes.

To manually redistribute the logical drives, complete the following steps:

a. Click the Support tab.

b. Select Manage Controllers, and then select Redistribute Logical Drives.

6. Make sure that the disks stay on the preferred path by using one or both of the
following methods:

Using the AIX system
Run the mpio_get_config -Av command and make sure that the drives
are on the expected path.

Using the Storage Manager software
In the Enterprise Management window, make sure that the storage
subsystems are Optimal. If they are not Optimal, make sure that any
drives that are part of the storage subsystems that are involved with
hot-swap process are not listed in the Recovery GURU.

7. Using the AIX system, run the Ispath command to make sure that all paths to
the hdisks are Enabled.

DS3000 error log messages

This section describes the possible errors that might be reported in the AIX error
log. You can view the AIX error log by running the errpt -a command.

You might need to validate your configuration or replace defective hardware to
correct the situation.

Note: The snapshot references in the following list equate to FlashCopy when
reported on a DS3000 storage subsystem.

* SC_DISK_PCM_ERR1: Subsystem Component Failure

The storage subsystem has returned an error indicating that some component
(hardware or software) of the storage subsystem has failed. The detailed sense
data identifies the failing component and the recovery action that is required.
Failing hardware components should also be shown in the Storage Manager
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software, so the placement of these errors in the error log is advisory and is an
aid for your technical-support representative.

* SC_DISK_PCM_ERR2: Array Active Controller Switch

The active controller for one or more hdisks associated with the storage
subsystem has changed. This is in response to some direct action by the AIX
host (failover or autorecovery). This message is associated with either a set of
failure conditions causing a failover or, after a successful failover, with the
recovery of paths to the preferred controller on hdisks with the autorecovery
attribute set to Yes.

* SC_DISK_PCM_ERRS3: Array Controller Switch Failure

An attempt to switch active controllers has failed. This leaves one or more paths
with no working path to a controller. The AIX MPIO PCM will retry this error
several times in an attempt to find a successful path to a controller.

« SC_DISK_PCM_ERR4: Array Configuration Changed
The active controller for an hdisk has changed, usually due to an action not
initiated by this host. This might be another host initiating failover or recovery, for
shared LUNs, a Redistribute operation from the Storage Manager software, a
change to the preferred path in the Storage Manager software, a controller being
taken offline, or any other action that causes the active controller ownership to
change.

» SC_DISK_PCM_ERRS5: Array Cache Battery Drained

The storage subsystem cache battery has drained. Any data remaining in the
cache is dumped, and is vulnerable to data loss until it is dumped. Caching is not
normally allowed with drained batteries, unless the administrator takes action to
enable it within the Storage Manager software.

+ SC_DISK_PCM_ERRG6: Array Cache Battery Charge Is Low

The storage subsystem cache batteries are low and need to be charged or
replaced.

* SC_DISK_PCM_ERR?7: Cache Mirroring Disabled

Cache Mirroring is disabled on the affected hdisks. Normally, any cached write
data is kept within the cache of both controllers, so that if either controller fails,
there is still a good copy of the data. This is a warning message stating that loss
of a single controller will result in data loss.

+ SC_DISK_PCM_ERRS8: Path Has Failed
The 1/O path to a controller has failed or gone offline.
* SC_DISK_PCM_ERRS9: Path Has Recovered.
The I/O path to a controller has resumed and is back online.
* SC_DISK_PCM_ERR10: Array Drive Failure
A physical drive in the storage array has failed and should be replaced.
* SC_DISK_PCM_ERR11: Reservation Conflict

A PCM operation has failed due to a reservation conflict. This error is not
currently issued.

* SC_DISK_PCM_ERR12: Snapshot Volume’s Repository Is Full

The snapshot volume repository is full. Write actions to the snapshot volume will
fail until the repository problems are fixed.

* SC_DISK_PCM_ERR13: Snapshot Op Stopped By Administrator
The administrator has halted a snapshot operation.
* SC_DISK_PCM_ERR14: Snapshot repository metadata error
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The storage subsystem has reported that there is a problem with snapshot
metadata.

SC_DISK_PCM_ERR15: lllegal I/O - Remote Volume Mirroring

The I/O is directed to an illegal target that is part of a Remote Volume Mirroring
pair (the target volume rather than the source volume).

SC_DISK_PCM_ERR16: Snapshot Operation Not Allowed
A snapshot operation that is not allowed has been attempted.
SC_DISK_PCM_ERR17: Snapshot Volume’s Repository Is Full

The snapshot volume repository is full. Write actions to the snapshot volume will
fail until the repository problems are fixed.

SC_DISK_PCM_ERR18: Write Protected

The hdisk is write-protected. This can happen if a snapshot volume repository is
full.

SC_DISK_PCM_ERR19: Single Controller Restarted
The 1/O to a single-controller storage subsystem is resumed.
SC_DISK_PCM_ERR20: Single Controller Restart Failure

The 1/O to a single-controller storage subsystem is not resumed. The AIX MPIO
PCM will continue to attempt to restart the I/O to the storage subsystem.

Redistributing logical drives in case of failure

If you enabled autorecovery on the AIX host, you do not need to redistribute logical
drives manually after a controller failover. However, if you have a heterogeneous
host environment, you might need to redistribute logical drives manually. Hosts that
do not support some form of autorecovery, or AlX hosts that have autorecovery
disabled, do not automatically redirect logical drives to the preferred paths.

To manually redistribute logical drives to their preferred paths, complete the
following steps:

1.

Repair or replace any faulty components. For more information, see the
Installation, User’s, and Maintenance Guide for the applicable DS3000 storage
subsystem.

To redistribute logical drives to their preferred paths, on the Subsystem

Management window, selecting the Support tab. Select Manage controller,
and then select Redistribute Logical Drives.

Note: If a large number of logical drives are configured on the DS3000 storage
subsystem, redistributing the logical drives might take 2 hours or more to
be completed, depending on the system activity level.

On the AIX systems, run the mpio_get_config -Av command to make sure that

all the logical drives are on the preferred controller, as shown in the following

example:
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# mpio_get_config -Av
Frame id 3:
Storage Subsystem worldwide name: 60ab80024585d000047fdb68
Controller count: 2
Partition count: 1
Partition 0:
Storage Subsystem Name = 'C4'

hdisk LUN # Ownership User Label
hdisk53 0 B (preferred) A-1-S5
hdisk54 1 A (preferred) A-10-S1
hdisk55 2 B (preferred) A-11-S0
hdisk56 3 A (preferred) A-12-S0
hdisk57 4 A (preferred) A-2-S5
hdisk58 5 B (preferred) A-3-S5
hdisk59 6 A (preferred) A-4-S5

Logical drives that are not on the preferred path will display “(non-preferred)” under
the Ownership heading.
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Chapter 4. Installing and configuring the Storage Manager
software on POWER-based Linux host systems

You can use the DS3000 Storage Manager software with the following Linux
distributions for POWER-based host operating systems:

* SUSE Linux Enterprise Server 9 (SLES 9)

* SUSE Linux Enterprise Server 10 (SLES 10)
* Red Hat Enterprise Linux 4 (RHEL 4)

* Red Hat Enterprise Linux 5 (RHEL 5)

Note: Before you begin any of the tasks in this chapter, see[*SUSE Linux

Enterprise Server system requirements’{and [‘Red Hat Enterprise Linux
system requirements” on page 55| for the system requirements for your Linux

distribution.

For more information about Linux on POWER and IBM System p support, see the
following Web sites:

Linux on POWER resource center
lhttp://www.ibm.com/servers/enable/linux/power|

Linux on System p support
http://www.ibm.com/servers/eserver/pseries/linux/

SUSE Linux Enterprise Server system requirements

This section lists the minimum hardware and software requirements for a
POWER-based host running SLES 9 or SLES 10 attached to a DS3000 storage
subsystem that is managed by the Storage Manager software.

Important: See the Storage Manager software readme file for Linux on POWER
for information about UTM LUN limitations. To get to the readme file,
see [‘Obtaining the documentation from the IBM Support Web site” on|

|9age 1 |

Host hardware requirements
The following minimum hardware is required.

Note: For the most current host support information, see the latest DS3000
interoperability matrix.

* DS3400 support:

— Any IBM System p or POWER server using the IBM POWER4, POWERS5, or
POWERS6 64-bit PowerPC architecture that supports one of the following Fibre
Channel host bus adapters:

- FC 6239

- FC 5716 /1957 /1977
- FC 5758 /1905

- FC 5759 /1910

- FC 5773

- FC 5774
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— IBM @server BladeCenter JS20 and IBM BladeCenter JS21, using the IBM
@server BladeCenter Fibre Channel expansion cards

» DS3300 support:
IBM @server BladeCenter JS20 and IBM BladeCenter JS21, using the QLogic
iISCSI Expansion Card for IBM @server BladeCenter

* Management station for the Storage Manager software
You can use the SLES host as the management station for the Storage Manager
software.

— For Microsoft® Windows® or i386-based Linux management stations, see the
minimum requirements listed for those operating systems in the IBM System
Storage DS3000 Storage Manager Version 2 Installation and Support Guide
for Microsoft Windows Server 2003, Linux, Novell NetWare, and VMware ESX
Server.

— For AIX or RHEL management stations, see the minimum requirements listed
in the applicable chapters in this document.

Software requirements

54

For the latest supported versions of each item listed in this section, see the Storage
Manager software readme file for Linux on POWER.

Note: To get to the readme file, see ['‘Obtaining the documentation from the IBM
[Support Web site” on page 1.|

SUSE Linux Enterprise Server 10
* Version: SLES 10
* Kernel: 2.6.18-8.xx-ppc64
» Version: SLES 10 with SP1
* Kernel: 2.6.16.46-xx-ppc64

SUSE Linux Enterprise Server 9
* Version: SLES 9
* Kernel: 2.6.5-7.xx-pseries64

Emulex Fibre Channel HBA
* Emulex device driver (SLES 9): Ipfc 8.0.16.27
* Emulex device driver (SLES 10): Ipfc 8.1.6.8
* Emulex device driver (SLES 10 SP1): Ipfc 8.1.18.9
» Application Kit (SLES 9): 3.3a20
« Application Kit (SLES 10): 3.0a15
» Application Kit (SLES 10 SP1): 3.2a14
QLogic Fibre Channel HBA

* QLogic device driver: 8.01.07.15
* Fibre Channel Application Kit: 5.0.0b17

QLogic iSCSI HBA
* Qlogic device driver: 5.01.00.08.02
* iSCSI Application Kit: 5.00.32

IBM Storage Manager RDAC MPP driver for SLES 9 and 10
rdac-LINUX-09.01.B5.xx-source.tar.gz
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IBM Storage Manager RDAC MPP driver for SLES 10 with SP1

rdac-LINUX-09.01.C5.xx-source.tar.gz

IBM Storage Manager software packages

SMIA-LINUXPPC-02.70.A5.xx.bin

Red Hat Enterprise Linux system requirements

This section lists the minimum hardware and software requirements for a
POWER-based host running RHEL 4 or RHEL 5 attached to a DS3000 storage
subsystem that is managed by the Storage Manager software.

Important: See the Storage Manager software readme file for Linux on POWER

for information about UTM LUN limitations. To get to the readme file,
see [‘Obtaining the documentation from the IBM Support Web site” on|
|page 1.|

Host hardware requirements
The following minimum hardware is required:
+ DS3400 support:

Any IBM System p or POWER server using the IBM POWER4, POWERS, or
POWER®6 64-bit PowerPC architecture that supports one of the following Fibre
Channel host bus adapters:

- FC 6239

- FC 5716 /1957 /1977
- FC 5758 /1905

- FC 5759/1910

- FC 5773

- FC 5774

IBM @server BladeCenter JS20 and IBM BladeCenter JS21, using the IBM
@server BladeCenter Fibre Channel expansion cards

+ DS3300 support:

IBM @server BladeCenter JS20 and IBM BladeCenter JS21, using the QLogic
iISCSI Expansion Card for IBM @server BladeCenter

* Management station for the Storage Manager software

You can use the RHEL host as the management station for the Storage Manager
software.

— For Windows or i386-based Linux management stations, see the minimum

requirements listed for those operating systems in the IBM System Storage
DS3000 Storage Manager Version 2 Installation and Support Guide for
Microsoft Windows Server 2003, Linux, Novell NetWare, and VMware ESX
Server.

For AIX or RHEL management stations, see the minimum requirements listed
in the applicable chapters in this document.

Software requirements

For the latest supported versions of each item listed in this section, see the Storage
Manager software readme file for Linux on POWER.

Note: To get to the readme file, see [‘Obtaining the documentation from the IBM

[Support Web site” on page 1.|

Chapter 4. Installing and configuring the Storage Manager software on POWER-based Linux host systems 55



Red Hat Enterprise Linux 5
* Version: RHEL 5
* Kernel: 2.6.18-8.xx-ppc64

Red Hat Enterprise Linux 4
* Version: RHEL 4
* Kernel: 2.6.9-65.xx-pseries64

Emulex Fibre Channel HBA
* Emulex device driver (RHEL 4): Ipfc 8.0.16.27
* Emulex device driver (RHEL 5): Ipfc 8.1.10.9
» Application Kit (RHEL 4): 3.3a20
» Application Kit (RHEL 5): 3.2a14

QLogic Fibre Channel HBA

* QLogic device driver: 8.01.07.15

* Fibre Channel Application Kit: 5.0.0b17
QLogic iSCSI HBA device driver

* Qlogic device driver: 5.01.00.08.02

+ iSCSI Application Kit: 5.00.32

IBM Storage Manager RDAC MPP driver for RHEL 4
rdac-LINUX-09.01.B5.xx-source.tar.gz

IBM Storage Manager RDAC MPP driver for RHEL 5
rdac-LINUX-09.01.C5.xx-source.tar.gz

IBM Storage Manager software packages
SMIA-LINUXPPC-02.70.A5.xx.bin

Linux host restrictions

Before you begin working with the Storage Manager software, read the following
restrictions. These restrictions apply to both the SLES and RHEL operating
systems, except as otherwise noted.

Important: See the Storage Manager software readme file for Linux on POWER
for information about UTM LUN limitations. To get to the readme file,
see [‘Obtaining the documentation from the IBM Support Web site” on|

bage 1.|
SAN and connectivity restrictions
* Dual-path configurations are supported only with the IBM RDAC failover
driver.
+ Single-switch configurations are allowed, but each HBA and DS3000
controller combination must be in a separate SAN zone or VLAN.

» For Fibre Channel, other storage devices, such as tape devices or other
disk storage, must be connected through separate HBAs and SAN
zones.

» As of the date of this document, clustering is not supported.

Note: For more information about zoning and enabling zones, see
‘Connecting host bus adapters in a Fibre Channel switch|
environment” on page 14.
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Linux RDAC restrictions (AVT/ADT)
This Linux RDAC release does not support auto-volume transfer/auto-disk
transfer (AVT/ADT) mode. AVT/ADT is disabled by default in the Linux
storage partitioning host type. Use the Linux storage partitioning host type
for Linux partitions.

Partitioning restrictions

» Dual-path configurations are supported only with the IBM RDAC failover
driver.

* The Linux SCSI layer does not support skipped (sparse) LUNs. If the
mapped LUNs are not contiguous, the Linux kernel does not scan any
LUNSs that occur after the skipped LUN, so the remaining LUNs are not
available to the host server. Therefore, always map the LUNs using
consecutive numbers, starting with LUN 0.

For example, map LUNs to numbers 0, 1, 2, 3, 4, 5, and so on, without
skipping any numbers.

* On each partition, you must map a LUN 0.

» On each controller, you must configure at least one partition with a LUN
between 0 and 31 that is not a UTM or access logical drive.

Installing the Storage Manager software

This section describes the procedures for installing the Storage Manager software.

Preparing for the software installation

Before you install the DS3000 Storage Manager software, you might need the
following items to prepare for the installation:

» For the Linux on POWER operating system, make sure that you are running the
operating-system-required maintenance level. (See the readme file for the
required maintenance levels and any additional fixes.)

* HBA drivers

» The most up-to-date controller firmware for your particular storage subsystem as

listed in ['SUSE Linux Enterprise Server system requirements” on page 53 or

[‘Red Hat Enterprise Linux system requirements” on page 55/

The IP addresses for RAID controllers (for out-of-band management only)

Additional documentation for switches and HBAs, if needed

» Applicable host software kit. The host software kit grants you permission to
attach host servers using the applicable operating system for the DS3000. The
kit includes the most up-to-date DS3000 software and controller firmware for your
particular storage subsystem.

» Applicable host attachment support CD for your operating system, which includes
the most up-to-date DS3000 software and controller firmware for your particular
storage subsystem.

For the latest controller firmware, see |http://www.ibm.com/servers/storage/support/

Best practice: When you start the host in preparation for installation of the Storage
Manager software packages, make sure that DS3000 devices are
not yet attached to the host system. Attaching DS3000 devices
before you configure the host increases system startup time, and
can complicate the installation process. Attach the DS3000 devices
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after you complete the procedures in this section, and before you
install the Storage Manager software.

Failover drivers

A Linux on POWER host system requires either the RHEL or the SLES Redundant
Disk Array Controller (RDAC) failover driver for 1/O path redundancy. The failover
driver monitors 1/O paths. If a component failure occurs in one of the I/O paths, the
failover driver reroutes all 1/0 to another path.

For information about installing the RDAC multipath driver, see [‘Installing the RDAC]|
Imultipath proxy driver” on page 64

Configuring the Linux host

After the Linux operating system is installed and before you install the Storage
Manager software, complete the procedures that are described in this section to
configure your Linux host for the DS3000 storage subsystem.

Installing the HBA device driver and utility packages

The type of HBA device driver that you need depends on your configuration. There
are different drivers for Fibre Channel or iSCSI host bus adapters. There might also
be different device drivers for the SLES and RHEL operating systems.

Note: For the latest supported versions of the following packages, see the DS3000
Storage Manager readme file for Linux on POWER.

SLES 10 with SP1 or RHEL 5 HBA driver support
For systems using SLES 10 with SP1 or RHEL 5, unless otherwise noted,
use the HBA device driver that comes with the operating system.

SLES 9 and RHEL 4 HBA driver support
You can download the following items from the DS3000 support Web site:
» Driver package
Compiles changes in the configuration file (/etc/Ipfc.conf)
» Application package
Monitors the HBAs and facilitates the downloading of the HBA firmware.
* Release notes
Contains the instructions for upgrading the device driver.

To install the HBA driver, complete the following steps:
1. Create a directory for the HBA driver package.

2. Go to jttp://www.ibm.com/servers/storage/support/disk/| and download the
applicable driver package to the directory that you just created.

3. Uncompress the file by typing the following command:
# tar -zxvf package_name.tgz

Note: If the RDAC is already installed on the system, the RDAC driver must be
unloaded or removed before installing the HBA device driver. Do not load
or unload the RDAC driver stack, which includes the mpp_Upper and
mpp_Vhba tools and the low level host bus adapter device driver, by
using the modprobe kernel module utility. Any use of the modprobe utility
on the RDAC driver stack is not supported. Using rmmod to remove all
the drivers in the RDAC driver stack, in order, is also not supported.
Each time you must unload the driver stack, restart the system.
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4. To update a physical HBA driver, complete the following steps:
a. Get the latest HBA drivers that are supported by MPP.
b. Install the drivers.

c. After the driver is installed, change back to the initial Linux RDAC installation
directory, and reinstall the RDAC driver using the following commands:

# make clean

# make uninstall
# make

# make install

5. Restart the server.

Installing the optional application kit
To install the optional application kit, complete the following steps:

1. Create a directory for the application package.

2. Go to http://www.ibm.com/servers/storage/support/disk/| and download the
applicable driver package to the directory that you just created.

3. Uncompress the file by typing the following command:
# tar -zxvf package name.tgz

4. In the directory, find the readme.txt file, and follow the instructions for installing
the driver package.

5. Restart the server.

Recording the HBA worldwide port nhames

During the installation process, you need to know the HBA worldwide port names.
To view and record the Fibre Channel HBA WWPNs or iSCSI HBA IQN, complete
the following steps for either Emulex-based HBAs or QLogic-based HBAs.

For Emulex-based HBAs:
1. Type the following command to view a the HBAs:
# 1s /proc/scsi/lpfc

A list containing the assigned numbers for all of the HBAs that are discovered
on the system is displayed.

2. In the list, identify the host number of the HBA that is connected to the DS3000
storage subsystem and go to that directory by typing the following command:

# cd /sys/class/scsi_host/host#

where # is the assigned HBA number that you discovered in step

3. Type the following command to view the WWPN of the HBA and connected
DS3000 controllers:

# cat port_name

where port_name is the assigned HBA number. The port_name value is
equivalent to the WWPN.

For QLogic-based HBAs:
1. Type the following command to view a the HBAs:
# 1s /proc/scsi/qla2x

or

# 1s /proc/scsi/qladx

Chapter 4. Installing and configuring the Storage Manager software on POWER-based Linux host systems 59


http://www.ibm.com/servers/storage/support/disk/

A list containing the assigned numbers for all of the HBAs that are discovered
on the system is displayed.

2. For each HBA that is connected to the DS3000 storage subsystem, type the
following command:

# cat /proc/scsi/q1a2300/x

where x is the assigned HBA number that you discovered in step [1 on page 59
The following information is displayed:

scsi-qla#-adapter-port-xxxxxxxxxxxxxx

The adapter port value xxxxxxxxxxxxxx provides the Fibre Channel WWPN or
iISCSI I1QN.

Storage Manager installation and configuration

After the host configuration procedure is completed, install and configure the
Storage Manager software by following the procedures in this section.

Note: Before you begin the Storage Manager software installation, make sure that
the DS3000 devices are attached to the host.

You can install all of the Storage Manager software packages automatically by
using the Storage Manager software installation wizard or you can install the
individual packages by using silent mode installation.

Installing Storage Manager using the installation wizard

The Storage Manager software installation wizard is a Java-based interactive
method for choosing which packages to automatically install on your host system.
The installation wizard installs the following software packages on the host:

e SMruntime
* SMclient
* SMagent
o SMutil

Requirements:
» DS3000 Storage Manager version 02.70, or later
» Xxservices must be operational

If you are installing Storage Manager version 02.70, if the system does not have a
graphics card installed, or if for any reason you do not want to use the wizard to
install the software, skip this section and install the standalone host software
packages using the procedures described in |“Insta|ling the Storage Managerl
lsoftware in console mode” on page 61.|

Note: If you use the wizard to install the Storage Manager software, you might
need to increase the size of some partitions to accommodate the installation.

To install the DS3000 Storage Manager software using the installation wizard,
complete the following steps. Adjust the steps as necessary for your specific
installation.

1. Copy the Storage Manager software SMIA package file from the System
Storage DS3000 Support software for Linux on POWER CD, or download the
package file from the DS3000 support Web site, to a directory on your system.
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2.

Open the file on your system by typing the following command:
# sh SMIA-LINUXPPC-02.70.A5.xx.bin

The Storage Manager Installation wizard Introduction window opens.

Follow the instructions in each window of the wizard. When you select the
installation type, you can choose one of the following options:

« Typical (Full) Installation—Installs all the Storage Manager software packages
* Management Station—Installs SMruntime and SMclient

* Host—Installs SMruntime, SMagent, and SMutil

« Custom—Enables you to select which packages you want to install

The DS3000 Storage Manager software is installed on your system.

Note: During the installation, you will see the question Automatically Start Monitor?

This refers to the Event Monitor service. If you want to enable automatic
ESM firmware synchronization, the Event Monitor must be enabled. To
enable the Event Monitor, select Automatically Start Monitor.

Installing the Storage Manager software in console mode

Use the following steps to install the Storage Manager software with out the
graphical interface.

1.

5.
6.

From a command prompt, run the Storage Manager installation package while
using the - i console parameter to forces the package to install in a
non-graphical mode. For Example, in Linux, the command is:

# sh SMIA-LINUXPPC-02.70.A5.15.bin — i console
Select the location (the default value is English) and press Enter.

Read the End User License Agreement (EULA). To continue, press Y (for Yes)
to accept the EULA.

Choose the installation type:

* Typical

* Management Station

* Host

* Customize

Press Enter.

Review the Pre-Installation Summary, and then press Enter.
The installation is completed. Press Enter to exit the installer.

Configuring storage subsystems

If you have purchased a Storage Partitioning premium feature, make sure that the
premium feature is enabled. For more information, see [Chapter 7, “Enabling and

lusing premium features,” on page 105.|

To configure the Storage Manager software for a Linux on POWER system,
complete the procedures in the following sections. You can configure the Storage
Manager software from the Storage Manager Client software running on either a
Linux on POWER or a non-Linux on POWER system.

Adding storage subsystems to the Storage Manager Client

To add storage subsystems to the Storage Manager Client (SMclient), complete the
following steps:
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1. To set up the storage subsystem for Linux on POWER and SMclient, the
storage subsystem must be physically configured for direct management
through the Ethernet connections on each controller. Install SMclient before
configuring the storage subsystem.

Note: For information about assigning IP addresses to the controllers, see
|“Step 3: Assigning IP addresses to hosts and controllers” on page 21 |

2. After the storage subsystem is configured on the network, start SMclient on the
host server by selecting the Storage Manager icon or by typing the following
command:

# /opt/IBM_DS3000/SMclient

The Enterprise Management window opens.
3. Complete the following steps to specify the IP addresses of the controllers:

a. In the Enterprise Management window, click Edit + Add Storage
Subsystem.

b. In the Add Storage Subsystem window, type the IP addresses of each
controller in the storage subsystem, and click Add. The name of the storage
subsystem is displayed in the Enterprise Management window.

Note: Failure to add both controllers in a dual-controller storage subsystem
results in a partially-managed system, where all functions might not
be available.

The name of the storage subsystem is displayed in the Enterprise

Management window.

Upgrading controller firmware and NVSRAM

For detailed procedures for downloading the firmware updates, see |“Downloadina
fcontroller, NVSRAM, ESM, and hard disk drive firmware” on page 93.

Creating storage partitions

To create storage partitions, complete the procedures in the following sections.

Storage partitioning overview

Before you create the storage partitions using the procedures in this section, read
the following information:

* The procedures in this section assume that you have already created a physical
connection between the host and the storage subsystem controllers, and that you
have also connected and zoned the SAN switch (if any). If you have not
completed these connections, the Storage Manager software is not able to list
the WWPNs or IQNs of the HBAs during these procedures. In this case you will
have to type the WWPNSs or IQNs in the applicable fields in the procedure for
defining a host and host ports.

* Create the Linux on POWER host group at the storage subsystem level. Do not
create host groups at the default group level.

» Auto volume transfer/auto-disk transfer (AVT/ADT) is managed by the Linux
RDAC driver. To avoid contention, AVT/ADT must be disabled. By default,
AVT/ADT is disabled. Selecting the Linux host type automatically disables
AVT/ADT.

62 DS3000 Storage Manager Installation and Support Guide for AIX and Linux on POWER



Defining the host and host port

To define the host and host ports by using the Configure Host Access wizard,
complete the following steps:

1.

10.

Select the Configure tab on the Subsystem Management window and select
one of the following methods:

» Create Host Access (Automatic)
» Create Host Access (Manual)

Select Create Host Access (Automatic) if you have added a new host that is
also running the host agent on the system. Otherwise go to step

If any host are automatically configured, they are displayed in the left column
as an Available Host. Select a host from the list of available hosts and click
Add.

After all the available hosts are moved to the Select Host column, click OK.
The host and host ports are defined and you have completed this procedure.

Select Create Host Access (Manual) to manually define the host and host
port information.

From the Specific Host Name and Host Type window, enter the host name and
then select Linux as the host type from the host type list. Click Next.

From the Specify HBA Host Port window, in the left pane, select the correct
WWPN or IQN of the HBA host port that will be used to define the host. Click
Add.

Note: If there is not a physical connection between the host and the DS3000
controllers, the WWPNs are not displayed. In this case, you must
manually enter the correct WWPN or IQN information by completing the
following steps:

a. Click New.

b. Enter the Fibre Channel WWPN or iSCSI IQN information.
c. Enter the host port alias.

d. Click Add.

After all the host ports are added to the Selected HBA host port column, click
Next.

From the Specify Host Group window, select one of the following options:

No: If the host will not share access to the same logical drive with other
hosts

Yes: If the host will share access to the same logical drive with other hosts

If No is selected, click Next.
If Yes is selected, either enter a New Host Group name or select an existing
host group from the list, then click Next.

Review the host definition details, and then click Finish.

The host and host ports are defined.

Defining a host group

A host group is an entity in the Storage Partitioning topology that defines a logical
collection of host computers that require shared access to one or more logical
drives. You can grant individual hosts in a defined host group access to storage
partitions, independently of the host group.

To define a host group, complete the following steps:
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4.
5.

Click the Configure tab on the Subsystem Management window.
Select Create Host Group.

Enter the new host group name (for example, Linux) and select the hosts from
the left column. Click Add to add them to the host group.

When all the hosts for the host group are added, click OK.
A message is displayed indicating that the new host group is created. Click OK.

Mapping LUNs to a storage partition

This section contains the procedures for mapping and adding LUNs to a host or
host group. These steps can be used to map LUNs to a new partition or add LUNs
to an existing partition.

To map LUNs, complete the following steps:

1.
2.
3.

Select the Configure tab on the Subsystem Management window.
Select Create Host-to-Logical Drive Mapping.

From the Select Host window, select the host or host group that the logical
drives will be mapped and click Next.

From the Select Logical Drives window, select the logical drives that will be
mapped to the host or host group that was selected in step .

Note: If all the logical drives will be mapped to the same host or host group,
then click the Select all logical drives check box.

After the logical drives are selected, assign a logical unit number (LUN) from 0

to 31, to the logical drives and click Finish.

The Host-to-Logical Drive Mapping progress window is displayed. When the
mappings are completed, click OK.

The mappings are completed. Select Yes to map additional logical drives or No
to complete the mappings wizard.

Completing the host configuration

After you install the Storage Manager software, complete the host configuration
procedures that are described in this section.

Installing the RDAC multipath proxy driver

This section describes how to install the RDAC driver for a dual-path
POWER-based Linux configuration.

Important: Before you install RDAC, make sure that the partitions and LUNs are

configured and assigned, and that the correct HBA driver is installed.

To install RDAC, complete the following steps:

1.

Download the RDAC driver package from the IBM DS3000 support Web site.

RDAC package for SLES 9, SLES 10, and RHEL 4:
rdac_LINUX_09.01.B5.xx_source_tar_gz

RDAC package for SLES 10 with SP1 and RHEL 5
rdac_LINUX_09.01.C5.xx_source_tar_gz2

Create a directory on the host and download the RDAC driver package to that
directory.

Uncompress the file by typing the following command:
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# tar -zxvf rdac-LINUX-package version-source.tar.gz

where package_version is the SLES or RHEL package version number that is

specified in step|1 on page 64
A directory named linuxrdac-version# (SLES 9, SLES 10, RHEL 4, and RHEL
5) is created.

4. Open the readme file that is included in the linuxrdac-version# directory.

5. In the readme file, find the instructions for building and installing the driver and
complete the steps, which include restarting the server.

Note: Make sure that you restart the server before you proceed to step@
6. Type the following command to list the installed modules:
# Tsmod
7. Make sure that the module entries are included in the Ismod list, as follows:
* mppVhba
* mppUpper
* Ipfc or gla2xxx

Note: If the mpp_Vhba module is not displayed, the usual cause is that the
server was restarted before the LUNs were assigned, so the mpp_Vhba
module is not installed. If this is the case, assign the LUNs now, restart
the server, and then repeat step

8. Type the following command to verify the driver version:
# mppUtil -V

9. Type the following command to verify that devices are configured with the
RDAC driver:

# 1s -1R /proc/mpp
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An output similar to the following example is displayed.

# 1s -1R /proc/mpp

/proc/mpp:

total 0

dr-xr-xr-x 4 root root 0 Oct 24 02:56 DS3400-sysl1
CrWXrWXrwX 1 root root 254, 0 Oct 24 02:56 mppVBusNode

/proc/mpp/ DS3400-sysl:

total 0

dr-xr-xr-x 3 root root 0 Oct 24 02:56 controllerA
dr-xr-xr-x 3 root root 0 Oct 24 02:56 controllerB
-rW-r--r-- 1 root root 0 Oct 24 02:56 virtuallLunO
-rW-r--r-- 1 root root 0 Oct 24 02:56 virtuallunl
-rW-r--r-- 1 root root 0 Oct 24 02:56 virtuallLun2
-rW-r--r-- 1 root root 0 Oct 24 02:56 virtuallLun3
-rW-r=--r-- 1 root root 0 Oct 24 02:56 virtuallLun4
-rW-r--r-- 1 root root 0 Oct 24 02:56 virtuallLunb

/proc/mpp/ DS3400-sysl/controllerA:

total 0

dr-xr-xr-x 2 root root 0 Oct 24 02:56 Tpfc_hbcOt2
/proc/mpp/ DS3400-sys1/controllerA/Ipfc_h6cOt2:

total 0

-rW-r--r-- 1 root root 0 Oct 24 02:56 LUNO
-rW-r=--r-- 1 root root 0 Oct 24 02:56 LUN1
-rW-r--r-- 1 root root 0 Oct 24 02:56 LUN2
-rW-r=--pr-- 1 root root 0 Oct 24 02:56 LUN3
-rW-r--r-- 1 root root 0 Oct 24 02:56 LUN4
-rW-r--r-- 1 root root 0 Oct 24 02:56 LUN5

/proc/mpp/ DS3400-sysl/controllerB:

total 0

dr-xr-xr-x 2 root root 0 Oct 24 02:56 T1pfc_h5c0t0
/proc/mpp/ DS3400-sysl/controllerB/1pfc_h6cOt2:

total 0

-rW-r--r-- 1 root root 0 Oct 24 02:56 LUNO
-rW-r--r-- 1 root root 0 Oct 24 02:56 LUN1
-rW-r==pr-- 1 root root 0 Oct 24 02:56 LUN2
-rW-r--r-- 1 root root 0 Oct 24 02:56 LUN3
-rW-r--r-- 1 root root 0 Oct 24 02:56 LUN4
-rW-r--r-- 1 root root 0 Oct 24 02:56 LUN5

Note: After you install the RDAC driver, the following commands and man pages
are available:

* mppUtil

* mppBusRescan
* mppUpdate

« RDAC

Performing initial device identification

The initial device identification procedures in this section apply to all the SLES and
RHEL distributions, and exceptions are noted.

Complete the procedures in this section in the following order:
1. |“Probing the SCSI bus” on page 67|
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2. [‘Associating each HBA WWPN with its assigned host port]
3. [Viewing the LUNS” on page 68
4. [‘Associating the system LUN devices with DS3000 LUNS” on page 70|

Probing the SCSI bus
To probe the SCSI bus, complete one of the following procedures, according to
whether RDAC is installed on your system.

* With RDAC installed:
Type the following command:
# mppBusRescan
* Without RDAC installed:
Remove the modules and reload them.
Type the following command to remove the modules:
# rmmod hba_device_driver

Type the following command to reload the modules:
# modprobe hba_device driver

Associating each HBA WWPN with its assigned host port
To associate each HBA WWPN with its assigned host port, complete the following
steps:
1. Type the following commands.
For Emulex-based HBAs:

# cd /proc/scsi/lpfc
# 1s

For QLogic-based HBAs:

# cd /proc/scsi/qla2xxx
# 1s

A list of HBAs is displayed, as shown in the following example:
.5432
2. For each HBA in the directory, type the following command:
# cat hba#

where hba# is an HBA in the directory. The HBA properties are displayed, as
shown in the following example:
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[root@x3650 /]# cat /proc/scsi/qla2xxx/2
QLogic PCI to Fibre Channel Host Adapter for QLE2462:
Firmware version 4.00.23 [IP] , Driver version 8.01.06
ISP: ISP2432
Request Queue = 0xbee80000, Response Queue = 0xbee40000
Request Queue count = 4096, Response Queue count = 512
Total number of active commands = 0
Total number of interrupts = 206796
Device queue depth = 0x20
Number of free request entries = 2212
Number of mailbox timeouts = 0
Number of ISP aborts = 0
Number of Toop resyncs = 0
Number of retries for empty slots = 0
Number of reqs in pending_q= 0, retry gq= 0, done_q= 0, scsi_retry q= 0
Host adapter:loop state = <READY>, flags = 0xlel3
Dpc flags = 0x4080000
MBX flags = 0x0
Link down Timeout = 030
Port down retry = 035
Login retry count = 035
Commands retried with dropped frame(s) = 0
Product ID = 0000 0000 0000 0000

SCSI Device Information:
scsi-qla0-adapter-node=200000e08b854260;
scsi-qla0-adapter-port=210000e08b854260;
scsi-qla0-target-0=203500a0b81d2b95;
scsi-qla0-target-1=203400a0b81d2b95;

FC Port Information:
scsi-qla0-port-0=200400a0b81d2b95:203400a0b81d2b95:0000e4:0;

3. Check the output to verify connectivity with the controllers. The output in the
previous example shows that one DS3000 with two targets scsi-qla0-target-0
and scsi-qgla0-target-1, with WWPN of 203500a0b81d2b95 and
203400a0b81d2b95, are attached to the HBA.

Viewing the LUNs
View the LUNSs by typing the following command:
# cat/proc/scsi/scsi
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The LUN properties are displayed, as shown in the following example.

[root@x3650 /]# cat /proc/scsi/scsi
Attached devices:
Host: scsi2 Channel: 00 Id: 01 Lun: 00

Vendor: IBM Model: 1726-4xx FAStT Rev: 0670

Type: Direct-Access ANSI SCSI revision: 05
Host: scsi2 Channel: 00 Id: 01 Lun: 01

Vendor: IBM Model: 1726-4xx FAStT Rev: 0670

Type: Direct-Access ANSI SCSI revision: 05
Host: scsi2 Channel: 00 Id: 01 Lun: 02

Vendor: IBM Model: 1726-4xx FAStT Rev: 0670

Type: Direct-Access ANST SCSI revision: 05
Host: scsi3 Channel: 00 Id: 01 Lun: 00

Vendor: IBM Model: 1726-4xx FAStT Rev: 0670

Type: Direct-Access ANSI SCSI revision: 05
Host: scsi3 Channel: 00 Id: 01 Lun: 01

Vendor: IBM Model: 1726-4xx FAStT Rev: 0670

Type: Direct-Access ANSI SCSI revision: 05
Host: scsi3 Channel: 00 Id: 01 Lun: 02

Vendor: IBM Model: 1726-4xx FAStT Rev: 0670

Type: Direct-Access ANSI SCSI revision: 05
Host: scsi4 Channel: 00 Id: 00 Lun: 00

Vendor: IBM Model: VirtualDisk Rev: 0670

Type: Direct-Access ANSI SCSI revision: 05
Host: scsi4 Channel: 00 Id: 00 Lun: 01

Vendor: IBM Model: VirtualDisk Rev: 0670

Type: Direct-Access ANSI SCSI revision: 05
Host: scsi4 Channel: 00 Id: 00 Lun: 02

Vendor: IBM Model: VirtualDisk Rev: 0670

Type: Direct-Access ANSI SCSI revision: 05

The previous example shows three LUNs, which are assigned to a partition with two
HBAs for dual-path, with RDAC installed.

Notes:

1. Each LUN is displayed on both of its configured paths. The active, assigned
HBAs are numbers 2 and 3.

2. The VirtualDisk is the RDAC logical disk. There is one VirtualDisk for each
LUN, regardless of the number of paths available.

3. If RDAC is installed, but you do not see any VirtualDisks in the output, the most
likely cause is that the mpp_Vhba module is not installed. (This happens if the
RDAC driver was installed before any LUNs were configured.) Use the Ismod
command to verify whether the mpp_Vhba module is installed. If it is missing
from the list of modules, make sure that the LUNs are configured, then restart
the host.

SLES 9 and SLES 10: On SLES operating systems only, you can use the Isscsi
command to view LUNs, instead of cat/proc/scsi/scsi. The advantage of using the
Isscsi command is that the output is easier to read, as shown in the following
example.
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[root@x3650 /]# 1sscsi

[62:0:0:0] disk IBM 1726-4xx FAStT 0270
[62:0:0:1] disk IBM 1726-4xx FAStT 0270
[12:0:0:2] disk IBM 1726-4xx FAStT 0270

[03:0:0:0] disk IBM 1726-4xx FAStT 0270 -
[03:0:0:1] disk IBM 1726-4xx FAStT 0270 -
[03:0:0:2] disk IBM 1726-4xx FAStT 0270 -
[04:0:0:0] disk 1BM VirtualDisk 0270 /dev/sdb
[04:0:0:1] disk 1BM VirtualDisk 0270 /dev/sdc
[04:0:0:2] disk 1BM VirtualDisk 0270 /dev/sdd

The fourth column shows the DS3000 model type and the sixth column shows the
Linux-assigned device number. In this example, only the Virtual RDAC devices are
assigned a system device name. If RDAC is not installed, system device names are
displayed for all of the devices listed in the output.

Associating the system LUN devices with DS3000 LUNs
To associate the system LUN devices with DS3000 luns, type the following
command:

# SMdevices

The device properties are displayed, as shown in the following example.

[root@x3650 /]# /opt/IBM DS3000/util/SMdevices

IBM System Storage DS4000/FAStT Storage Manager Devices, Version 09.17.A5.01
Built Wed Mar 28 11:53:31 CST 2007

(C) Copyright International Business Machines Corporation, 2003-2007 Licensed Ma
terial - Program Property of IBM. All rights reserved.

/dev/sdb (/dev/sgl) [Storage Subsystem DS3K_SATA Test, Logical Drive data-1, LUN 0O,
Logical Drive ID <600a0b80001d2b9500004d80469bbb18>, Preferred Path (Controller-A):
In Use]

/dev/sdc (/dev/sg2) [Storage Subsystem DS3K_SATA Test, Logical Drive data-2, LUN 1,
Logical Drive ID <600a0b80001d2b9500004d82469bbb20>, Preferred Path (Controller-A):
In Use]

/dev/sdd (/dev/sg3) [Storage Subsystem DS3K_SATA Test, Logical Drive data-3, LUN 2,
Logical Drive ID <600a0b80001d2b9500004d7e469bbaad>, Preferred Path (Controller-A):
In Use]

The previous example shows the assigned system device numbers that are
associated with the DS3000 storage subsystem name, and storage assigned LUN
ID, as they are displayed on the DS3000 storage subsystem.

On SLES and RHEL operating systems, you can use the following steps instead of
using SMdevices to display device properties.

Type the following command from the linuxrdac directory:

# lsvdev
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The following is an example of the Isvdev command output:

[root@x3650 mppl# ./1svdev

Array Name Lun sd device

DS3K_SATA Test 0 -> /dev/sdb
DS3K_SATA Test 1 -> /dev/sdc
DS3K_SATA Test 2 -> /dev/sdd
DS3K_SATA Test 3 -> /dev/sde
DS3K_SATA Test 4 -> /dev/sdf
DS3K_SATA Test 5 -> /dev/sdg

Performing common maintenance tasks

This section describes some common system administration tasks. The procedures
in this section apply to both SLES and RHEL installations. The exceptions are
noted.

Checking LUN size

To check the size of a LUN, complete the following steps:
1. Type the following commands:

#cd /sys/block/sdxx
# cat size

where xx is the device name.
A number is displayed, as shown in the following example:
8388608
2. Multiply this number by 512 (bytes) to calculate the size of the LUN, as shown
in the following example:
8388608 x 512 = 4294967296 (™ 4GB)

The result of the calculation is the size of the LUN. In the example, the LUN
size is approximately 4 GB.

Using dynamic capacity expansion and dynamic volume expansion

This section explains how to use dynamic volume expansion (DVE) with Linux on
POWER.

Dynamic volume expansion (DVE) increases the size of a logical drive. To perform
a DVE, there must be free capacity available on the array. If there is not, you can
first perform a dynamic capacity expansion (DCE) to increase the capacity of the
array by adding drives.

Before you begin: Make sure that there is sufficient available free capacity within
the array. Free capacity can be determined using the DS3000 Storage Manager
software. In the Summary/Arrays & Logical Drives view of the Subsystem
Management window, expand the desired array and scroll to the bottom of the
logical drives list. Available free capacity is an entry in the logical drives list.

Performing a dynamic capacity expansion operation
To perform a dynamic capacity expansion operation, complete the following steps:

1. In the Modify/Add Free Capacity (Drives) view, select the array whose capacity
is to be increased.
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2. Select Next.
3. Select an available drive in the “Add capacity to array” window.
4. Select Finish.

Note: The available free disks and their capacity are displayed in the window.

After the operation is started, a clock is displayed beside every logical drive in the
array and remains until the operation is completed. The process might take several
hours and must be allowed to complete before continuing to the next steps.

Note: The time required for the operation to be completed depends on the 1/0
activity, capacity being added, drive technology, and other factors.

Performing a dynamic volume expansion operation
Performing a dynamic volume expansion requires the functionality of the Storage
Manager software SMcli interface or the Storage Manager software script editor.

The following example shows the command syntax that is required to run the
dynamic volume expansion from the script editor window on a logical drive named
Engineering_FEB. The capacity added is 1 GB.

set logicalDrive ["Engineering FEB"] addCapacity=1GB;

For more information about expanding Logical VolumeManager (LVM) logical drives,
see the man page for the chvg command.

To perform a DVE on the Linux host, complete the following steps:
1. Stop I/O to the logical drive whose size you want to increase.
2. Unmount the logical drive, if it is mounted.

3. From the Storage Manager software SMcli interface or the Storage Manager
software script editor, enter the following command:

set logicalDrive [logical_drive_name] addCapacity=xGB;

where logical_drive_name is the name of the logical drive that will increase and
X is the amount to increase the logical drive.

Note: You must wait for the process to complete before you can begin any host
intervention. If the storage subsystem is busy, this process might take
several hours to complete.

4. When the LVE process is complete, on the host, rescan the logical drive by
typing the following commands:

# cd /sys/block/sdxx/device
# echo 1 > rescan

where xx is the device name.

5. Check the size of the logical drive using the steps that are described in
[‘Checking LUN size” on page 71/

6. Remount the logical drive.

Using the SMdevices utility to find information about LUNs

SMuitil features an important utility, SMdevices, which you can use to map the
host-assigned device name for each LUN back to its corresponding DS3000
storage subsystem device.
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In the SMdevices output, you can view the DS3000 storage subsystem information,
as it is shown on SMclient.

Note: The examples in the list refer to the sample SMdevices output.

The following example shows a sample SMdevices output for the subsystem

DS3K_SATA_Test.

[root@x3650 /]# /opt/IBM_DS3000/util/SMdevices

IBM System Storage DS4000/FAStT Storage Manager Devices, Version 09.17.A5.01
Built Wed Mar 28 11:53:31 CST 2007

(C) Copyright International Business Machines Corporation, 2003-2007 Licensed Ma
terial - Program Property of IBM. All rights reserved.

/dev/sdb (/dev/sgl) [Storage Subsystem DS3K_SATA Test, Logical Drive data-1, LUN 0O,
Logical Drive ID <600a0b80001d2b9500004d80469bbb18>, Preferred Path (Controller-A):
In Use]

/dev/sdc (/dev/sg2) [Storage Subsystem DS3K_SATA Test, Logical Drive data-2, LUN 1,
Logical Drive ID <600a0b80001d2b9500004d82469bbb20>, Preferred Path (Controller-A):
In Use]

/dev/sdd (/dev/sg3) [Storage Subsystem DS3K SATA Test, Logical Drive data-3, LUN 2,
Logical Drive ID <600a0b80001d2b9500004d7e469bbaad>, Preferred Path (Controller-A):
In Use]

* Host assigned name: /dev/sdb

+ DS3000 storage subsystem name: DS3K_SATA Test
» Logical drive name: data-1

 LUN ID: LUN 0

» Preferred controller owner, and whether that controller is currently controlling the

logical drive

Viewing or changing queue depth

Setting the queue_depth attribute to the applicable value is important for system

performance. If you have a large DS3000 configuration with many logical drives and

hosts attached, use this setting for high performance.

This section provides methods for calculating your system maximum queue depth,

which you can use as a guideline to help you determine the best queue depth

setting for your configuration.

Calculating maximum queue depth

On DS3000 storage subsystems, use the following formula to calculate the

maximum queue depth for your system:

2048 / (number-of-hosts x LUNs-per-host)

For example, a system with four hosts, each with 32 LUNs, has a maximum queue

depth of 16:
2048 /(4 x32)=16

Important:

* The maximum queue depth might not be an optimal setting in all cases. Use the
maximum queue depth as a guideline, and adjust the setting as necessary for
your specific configuration.
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* In systems with one or more SATA devices attached, you might need to set the
queue depth attribute to a lower value than the maximum queue depth.

Viewing the current queue depth
To see the queue depth of each LUN, type the following command:

# cat /proc/scsi/sg/{device_hdr,devices}

Note: If RDAC is installed, the queue depth number that is displayed in the output
is not the same as the host setting for queue depth, because the RDAC
driver takes two queues for each LUN. For example, in the following sample
output, the queue depth of LUNs mapped to host 11 is set to 10; because
RDAC is installed, the output shows a queue depth of 8.

host
0

0

11
11
11
11
11

0

[cNoRoNoNoNo)

N N N e

#cat /proc/scsi/sg/device_hdr devices
chan

Tun type opens  qdepth busy online
0 5 0 2 0 1
0 0 3 8 0 1
0 0 0 8 0 1
1 0 0 8 0 1
2 0 0 8 0 1
3 0 0 8 0 1
4 0 0 8 0 1

Changing the queue depth
To change the queue depth, complete the following steps:
1. Using the vi editor, open one of the following configuration files for editing,
according to your operating system:
* SLES 9 and SLES 10:
/etc/modprobe.conf.local
* RHEL 4 and RHEL 5:
/etc/modprobe.conf
2. Add one of the following option parameters to the configuration file, according to
the type of HBA:
* Emulex-based HBA: Ipfc_lun_queue_depth=xx
* QLogic-based HBA: gl2xmaxqdepth=xx

where xx is the new queue depth value.
3. Set the new queue depth value, as follows:
* With RDAC installed:
Type the mppUpdate command, then restart the server.

* Without RDAC installed:
Uninstall the applicable HBA driver, and then reload it.

Example: To change the queue depth value to 10 on an RHEL 4 system with an
Emulex-based HBA and a QLogic-based HBA, type the following
commands:

# vi /etc/modprobe.conf
options 1pfc Tpfc_lun_queue_depth=10
options qla2xxx ql2xmaxqdepth=10
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Chapter 5. Completing the Storage Manager software
installation and configuration

This chapter contains information about using the Enterprise Management and
Subsystem Management features of the Storage Manager 2 software to complete
the installation tasks for the AIX and Linux on POWER operating system
environments.

To complete the Storage Manager 2 software installation, perform the following
tasks. Each of these tasks is discussed in detail in the following sections.

© © N O~ DN~

Perform a discovery of storage subsystems.
Add devices, if necessary.

Set up alert notifications, if you want to.
Name the storage subsystems.

Download firmware and NVSRAM.

Create arrays and logical drives.

Configure the heterogeneous hosts.

Map logical drives to a partition.

Perform other storage subsystem tasks.

Starting the Storage Manager software and discovering storage

subsystems

© Copyright IBM Corp. 2007

To start the Storage Manager software and discover storage subsystems, complete
the following steps:

1.

Choose one of the following commands:
* For AIX: Enter /usr/SMsmclient/SMclient
» For Linux: Enter /opt/IBM _DS3000/client/SMclient (by default).

The client software starts and the Enterprise Management window opens. Then,
the Task Assistant window (shown in|Figure 9 on page 79) and the Select
Addition Method window (shown in|Figure 7 on page 76)) open on top of the
Enterprise Management window.
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l ikil Select Addition Method

Your matagernent domain is not configured to monitor or manage any storage
zubsystems. Choose a method for the addition of storage subsystems:

f* ftomatics

Dizcovers storage subsystems automatically within the local sub-network.
| The dizcovery process may take several minutes o complete.

 manual:

Add storage subsystems by host or cortroller IP address or host name. This
option iz typically uzed only to add a storage subsystem that iz outside the
local sub-netvwork.

Cancel | Help |

Figure 7. Select Addition Method window

2. Select Automatic to discover all hosts and storage subsystems that are
attached to the local subnetwork. Select Manual to specify the IP address of a
device that is attached to the local subnetwork.

Note: The Enterprise Management window can take up to 1 minute to refresh
after an initial automatic discovery.

3. Make sure that each host and storage subsystem is displayed in the Enterprise
Manager window.

If a host or storage subsystem is not displayed, complete the following tasks:

* Check the hardware and hardware connections for possible problems (see
the hardware documentation for specific procedures).

* For more information about discovering storage subsystems, see the
Enterprise Management online help.

» If you are using the direct-management method, make sure that all hosts and
storage subsystems are connected to the same subnet network. If you are
using the host-agent method, make sure that the 1/0 connection between the
host and the storage subsystem is made.

* Make sure that all of the preparation steps for setting up the storage
subsystem for a direct-managed system in|[Chapter 2, “Preparing for]
installation,” on page 17 are completed. If they are, use the Add Device
option to add the IP addresses of the storage subsystem. Add both IP
addresses of the controllers. Otherwise, a partially-managed device error
message is displayed when you try to manage the storage subsystem.
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* If you are using the host-agent management method, complete the following
steps:

a. Make sure that the SMagent is installed on the host.

b. Make sure that you have a valid I/O connection from the storage
subsystems to the host in which the SMagent is installed.

c. Make sure that all of the preparation steps that are outlined in|Chapter 2,
|“Preparing for installation,” on page 17| are complete. If they are, complete
the following steps:

1) Run the hot_add utility.
2) Restart the SMagent, using the information in|“Stopping and restartind
the host-agent software” on page 103)

3) On the Enterprise Management window, click the host and
click Tools » Rescan.

Note: In certain situations, a storage subsystem might be duplicated in the
device tree after an automatic discovery. You can remove a duplicate
storage management icon from the device tree by using the Remove
Device option in the Enterprise Management window.

Make sure that the status of each storage subsystem is Optimal. If a device
shows a status of Unresponsive, right-click the device and select Remove
Device to delete it from the management domain. Then, use the Add Device
option to add it to the management domain again. For instructions for removing
and adding devices, see the Enterprise Management window online help.

Figure 8| shows the Enterprise Management window after an initial automatic
discovery.

l:iiIBM Sysem Sturge D53l] Sturag Manager 2 (Enterprise Management} i = IEIIﬂ

| Edit “iew Tools Help %
A @UE i A

= I Iame I Typel Statuz Metwork Management Type I Comment I

B {-Band Storage Subsystems [SCSI2-MS-S0y ) optimal Out-of-Band

) storage Subsystem ISCEI2-MS-SW sesi-alel BH © optimal Out-of-Band

O storage Subsystem 5CEH OLET scan-linnx B & Optimal Out-of-Band
far-iscsi Optimsl Out-of-Band

@Storage Subzystem ISCSI5-Linux arisest @ @ e at-=an

@Storage Subzystem far-iscsi

@ I IAutomat\c discovery campleted. Found 4 host(s) andior storage subsystem(s).

Figure 8. Enterprise Management window
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Using the Task Assistant

When you start the Storage Manager software, the client software starts, and the
Enterprise Management window opens. Then, the Task Assistant window opens and
provides a central location from which you can choose to perform the most common
tasks.

Note: The Task Assistant window opens automatically each time you open the
Enterprise Management window, unless you select the Don’t show the task
assistant at start-up again check box at the bottom of the window.

The Task Assistant provides shortcuts to the following tasks:
» Adding storage subsystems

* Naming or renaming storage subsystems

» Configuring alerts

* Managing storage subsystems

[Figure 9 on page 79|shows the Enterprise Management Window Task Assistant.
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il Enterprise Management Window Task Assistant

What are the Enterprize and Subsystetn Management Windows'?

Which Task Would You Like To Perform?
The Taszk Assistant helps you complete tasks guickly and easily within the Enterprize Management
Windowy. Please choose atask:

Initial Setup:

Add Storage Subsystems
You must add a storage subsystem to the management domain befare it can be
configured ar managed.

MamefRename Storage Subsystems
Marnitig & storage subsystem and providing a comiment makes it easy to find the
array within the management domain or determine itz physical location.

Configure Aletts
Iﬁ h Configuring aletts alloves you to receive email or =MMP nhotification whenever
|1L| U | there are critical problems on & storage subsysten.

Subsystem Management:

Manace a Storage Subsystem
Launch the Subsystem Management YWindowe to perform configuration tasks Sjll
»

e R s N S e e g e R e e iy e G G 2 _..|._.._1_1.. o

K

{1 Don't showe the task assistant &t start-up again
Mote: To dizplay the Tazsk Assistant again, zelect YWiew == Tazk Azsistant.

Figure 9. Enterprise Management Window Task Assistant

To open the Task Assistant after you have started the Storage Manager software,
click View » Task Assistant from the Enterprise Management window, or on the

toolbar, click the Task Assistant icon .

Adding storage subsystems

To manually add more hosts or storage subsystems, from the Enterprise
Management window, click Edit » Add Storage Subsystem. You can use this
option to selectively manage a group of storage subsystems from a Storage
Manager Client, and you can add devices that are to be managed and were not
discovered during the initial discovery. For more information, see the Enterprise
Management window online help.

Important:

* When you add an unidentified device, a window opens confirming that the device
was successfully added and that you can manage the storage subsystem. Any
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device that is listed in the unidentified device group will not be able to be
managed until it is discovered correctly. Make sure that the connections are
made, and try to add the device again.

* When you add new storage subsystems to the existing storage subsystems in a
SAN that are managed through the host-agent software, you must stop and
restart the host-agent service. When the host-agent service restarts, the new
storage subsystem is detected. For more information, see
|restarting the host-agent software” on page 103] Then, go to the Enterprise
Management window and click Tools » Rescan to add the new storage
subsystems to the management domain.

* When you add new storage subsystems to existing storage subsystems that are
managed through the direct (out-of-band) management method, be sure to
specify the IP addresses for both controllers.

Naming storage subsystems

To name your storage subsystem, complete the following steps:

1. In the Enterprise Management window, select a storage subsystem, right-click
the storage subsystem and select Rename. The Rename Storage Subsystem
window opens.

‘ =101 ]
Edit  Yiew Tools Help %
A QB BBl A
EI—34Bboﬂom Marme ITypeI Status Metwark Management Type I Comment |

IJ:'|—Ou1-Uf-Eiand Storage Subsystems FLLL % @ Optirnal Cut-of-Band
yatem FULL

iil Rename Storage Subsystem

Storage Subsystem name (max 30 characters]

ke I Cancel | Help |

[} I |Automatic discovery completed. Found 1 host{s) and/or storage subsystem(s).

Figure 10. Rename Storage Subsystem window

2. Type the name of the storage subsystem (see [Table 12 on page 109). Then,
click OK. A warning message is displayed stating that changing the storage
subsystem name can cause host applications to lose access to the storage
subsystem. Click Yes to continue or No to cancel naming the storage
subsystem.

3. Repeat this procedure for each unnamed storage subsystem. For more
information, see the topic about renaming storage subsystems in the Subsystem
Management window online help.
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Configuring alerts

After you add devices to the management domain, you can set up alert notifications
to report critical events on the storage subsystems. The following alert-notification
options are available:

» Notification to a designated network management station (NMS) through Simple
Network Management Protocol (SNMP) traps

* Notification to designated e-mail addresses

Note: You can monitor storage subsystems only within the management domain. If
you do not install the Event Monitor service, the Enterprise Management
window must remain open. If you close the window, you will not receive any
alert notifications from the managed storage subsystems. For more
information, see the Enterprise Management window online help.

To set up alert notification, from the Enterprise Management window, click Edit -
Configure Alerts.

To set up alert notification to a network management station (NMS) by using SNMP
traps, complete the following steps:

1. Insert the host kit support CD into the CD drive on an NMS. You must set up
the designated management station only once.

2. Copy the SM2.MIB file from the SM2MIB directory to the NMS.
3. Follow the steps that are required by your NMS to compile the management
information base (MIB) file. For more information, contact your network

administrator or see the documentation that comes with your
storage-management software.

The Initial Setup Tasks window
From the Subsystem Management window, you can open the Initial Setup Tasks
window, which contains links to the following tasks.
» Locating the storage subsystem
* Renaming the storage subsystem
» Setting the storage subsystem password
» Configuring host access
* Managing iSCSI settings (DS3300 only)
» Configuring the storage subsystem

To open the Initial Setup Tasks window, complete the following steps:

1. In the Enterprise Management window, double-click the storage subsystem for
which you want to perform the setup tasks. The Subsystem Management
window opens.

2. Click the Summary tab.

3. On the Summary page, click Perform Initial Setup Tasks. The Initial Setup
Tasks window opens, as shown in [Figure 11 on page 82|
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% isCSI3-Linux - Initial Setup

Uze these 6 steps to =t up the starage subsystem:
bieny Information About These Tasks| ﬂ

0 1) Locate the Storage Subsystem

{2} Rename the Storage Subsystem

13 Set a Storage Subsystem Password

L4 | Confiqure Host Access

L8 Manage i2CSl Settings:
Change Target Authentication
Erter Mutusl &uthertication Permizsions
Change Target Idertification

Change Target Discovery
Configure iZCE] Host Pords

&) Configure storage subsystern (2 options):

Automatic (Simple]

Manual (Advanced) _I
b

[V Do not show this again for this storage subsystem

Close |

Figure 11. Initial Setup Tasks window in the Subsystem Management window

Note: The Initial Setup Tasks window opens automatically each time you open the
Subsystem Management window, unless you select the Do not show this
again for this storage subsystem check box at the bottom of the window.

Creating a storage subsystem profile

Important: Create a storage subsystem profile and save it in a safe place
whenever you modify the arrays and logical drives in the storage subsystem. This
profile contains detailed controller information, including logical and physical disk
configuration information, that you can use to help recover the configuration in the
event of a failure. Do not save the profile in the logical drives that are created in the
DS3000 storage subsystem whose profile was collected and saved.

To save the storage subsystem profile, complete the following steps:

1. On the Subsystem Management window, click Summary » Storage Subsystem
Profile. The Storage Subsystem Profile window opens.

2. Click Save As.
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3. Select the sections that you want to save, and provide the file name in which to
save the Profile.

You can also click Support » Gather Support Information, as shown in|Figure 12
to collect the inventory, status, diagnostic, and performance data from the storage
subsystem and save them to a single compressed file.

Suppart > Gather Suppart Information
Gather Support Information

Specify a file name and location for the support data file and click start to save =l support data.

Fil:

[ Browse,
Shart Close

Figure 12. Gather Support Information window

Configuring host access

Before you use the logical drives in a host server, you must define and configure a
host for access.

To configure host access, complete the following steps:

1. Click the Configure tab in the Subsystem Management window. Choose one of
the following options:

* To configure host access automatically, click Configure Host Access
(Automatic) and follow the wizard instructions. After you have completed the
instructions in the wizard, you are finished with this procedure.

Note: To detect hosts automatically, the Storage Manager 2 Agent service
must be running. Make sure that SMagent is installed before you
proceed.

* To configure host access manually, click Configure Host Access (Manual)
and continue to step [}

2. When the Configure Host Access (Manual) wizard starts, specify a host name
and host type, and then click Next.

Note: Before you use the logical drives in a host server, you must specify the
correct host type. The host type determines how the storage subsystem
controllers will work with each operating system on the hosts to which
the controllers are connected. For the supported host types, see the
Storage Manager software readme file.
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3. When the Specify HBA Host Ports area is displayed, add the known or new
host bus adapters in the Selected HBA host port identifiers/aliases field, and
then click Next.

4. (Optional) When the Specify Host Group area is displayed, specify a host
group that will share access with logical drives. When you specify a host group,
you can create a new host group or select an existing host group that has
already been defined. Select No or Yes, and then click Next.

Defining host groups

A host group is an entity in the Storage Partitioning topology that defines a logical
collection of host servers that require shared access to one or more logical drives.
You can grant individual hosts in a defined host group access to additional logical
drives that are not shared by other nodes, but this requires an additional storage
partition. You can make logical drive-to-LUN mappings to the host group or to an
individual host in a host group.

Important: If you have purchased a Storage Partitioning premium feature, make
sure that the premium feature is enabled. See the instructions for
enabling premium features that came with your key, or contact your
technical-support representative if you are unable to enable a premium
feature.

Note: You can configure heterogeneous hosts when you define a host group. This
enables hosts running different operating systems to access a single storage
subsystem.

To define a host group, complete the following steps:

1. On the Subsystem Management window, click Configure » Create Host Group
to start the Create Host Group wizard.

2. When the Create Host Group area is displayed, enter a name for the host
group and add any available hosts to the host group.

3. Click OK.

Note: To add hosts to the host group at this time, available hosts must already
be configured for access. You can first create a host group without
adding hosts and then add hosts later, using the Create Host Access
(Manual) wizard. For more information, see [‘Configuring host access” on|

Creating arrays and logical drives

A redundant array of independent disks (RAID) array is a set of hard disk drives
that are logically grouped together.

A logical drive is a logical structure that is the basic structure that you create to

store data on the storage subsystem. The operating system recognizes a logical
drive as a single drive. Choose a RAID level to meet application needs for data

availability and to maximize 1/O performance.

The maximum number of drives that are supported in an array is 30. Each array
can be divided into 1 through 256 logical drives.
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To create arrays and logical drives, complete the following steps:

1. From The Enterprise Management window, double-click a storage subsystem
to open a Subsystem Management window.

2. Click the Configure tab.

3. Click Create Logical Drives. The Create Logical Drives wizard starts and the
Select Capacity Type window opens.

E5 FULL IBM System Storage DS3000 Storage Manager 2 (Subsysten Management) i =10l x|

Ee | | & O

| Ssummary | Configure Support |

Confiaure = Create Logical Drives

Create Logical Drives - Select Capacity Type @ view Frequentty Asked Quedlions

Choose the type of capacity to use:
@ Unconfigured capacity: create a new an array and logical drive.

€ Fres capacity: use capacity from an existing array.

Select a free capacity node:

% Arvety 3 (RAID 5)
% Array 4 (RAID 51
% Arrery 5 (RAID 3)
a % Array 6 (RAID 5)
% Array 7 (RAID 31
% Aty 6 (RAID 5)
i % Array 8 (RAID 5)

hiest = cancel

Figure 13. Create Logical Drives wizard window

4. Select Unconfigured capacity or Free capacity, and then click Next.

Note: When you select Free capacity, you must first select the free capacity
node from an existing array before you proceed with the wizard.

If you select Unconfigured capacity, skip to step|10 on page 87|

5. From the Select drive type list, select SAS or SATA.
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% FC IBM System Storage DS3000 Storage Manager 2 (Subsystem Management) 1

B Initial Setup Tasks

e = B - - |
AR AR
| Summarny Configure Mod_ify Tools Support |
Confiqure > Create Logical Drives
ij Create Logical Drives - Select Capacity Type @ View Frequentty Asked Questions

Choose the type of capacity to use:

¥ Unconfigured capacity: create a new an array and logical drive.

Select drive bype:

[

& i LAY = capacity from an existing array,
[ sas
Selert afree capacity node:

covs |

Figure 14. Selecting the capacity type

Note: You must create arrays by using drives that have the same disk type.
You cannot mix both SATA and SAS drives within the same array.

6. When the Drive Selection Choices area is displayed, select either Automatic
or Manual and click Next. If you select Automatic, continue to stepﬂ If you
select Manual, skip to step

Note: Selecting Automatic is preferred for quick and easy configuration. This
method enables you to choose from a list of automatically generated
drive and capacity options. Selecting Manual gives advanced users a
method for specifying drives to create a new array.

7. When the Choose Configuration (Automatic Configuration) area is
displayed, select a RAID level and click Finish.

Note: Depending on the selected RAID level, the automatic configuration
configures all remaining unconfigured capacity that is currently available
on the storage subsystem. Check the Configuration summary field for
details about what will be configured.

8. When the Manual Drive Selection area is displayed, as shown in
select the RAID level. Select the drives from the Unselected
drives area and click Add to move the drives to the Selected drives area. In
the Selected drives area, click Calculate Capacity, and then click Next.
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3 FULL IBM System Storage DS3000 Starage Manager 2 (Subsystem Management) ) 1ol x|

|| a 9
Summary | Configure Modify Tools Support |
Confioure > Create Losical Drives
Create Logical Drives - Manual Drive Selection @ view Freouerty Asked Questions.

Choose & RAID level, add drives, and caloulats the capacity for the array

RAID levet

- Select ot least 3 drives (up 10 & maximum of 30)
feps =
nselected drives: elected drives:
En...[ it | Capacity Speed (ram) Type [ en.| st Capacity Speed (ram) Type
i 11 780 10,002 545 &  e7smecE 10002 545
i 12 s7mscE 10,002 sas & e7amsce 10,02 sas
2 2 e7eeecE 10,002 543 i = 10 e7sEeGE 10002 545
3

5 67.866GB 1516 s
“Remove
ety
RAID 5 array capacity: 135.731 GB
Murmber of drives: 3
Enciosure oes pratection: () No
< Back hext = Cancel

Figure 15. Manual drive selection area

9. When the Specify Logical Drive area is displayed, specify the capacity,
name, and I/O characteristics of the logical drive, and click Next.

10. When the Map Logical Drive To Host area is displayed, select Map now to
map a logical drive immediately, using the host that you defined in
|host access” on page 83|or Map later to map a logical drive at a later time,
and then click Next.

Notes:

a. If you did not configure hosts previously, a warning message is displayed.
Read the message and click OK; then, continue with the Create Logical
Drives wizard.

b. To map the logical drive immediately, you must have previously configured
a host or host group (be sure to assign a LUN number for your logical
drive before you continue). If you select Map later, you can map the logical
drive through the Create Host-to-Logical Drive Mappings wizard. For more
information, see[‘Mapping LUNSs to a partition.’]

Note: For cluster configurations, if you add or delete logical drives, you must make
them known to both nodes A and B.

Mapping LUNs to a partition

Logical unit numbers (LUNs) are assigned to each logical drive when they are
mapped to a partition.

To map LUNs to a new or existing partition, complete the following steps:

1. On the Subsystem Management window, click Configure » Create
Host-to-Logical Drive Mappings to start the wizard.

2. When the Select Host area is displayed, select a host or host group and click
Next.
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CS11-MS5W IBM System Storage DS3000 Storage Manager 2 {Subsystem Management)

B Initial Setup Tasks

¢ | @

Summany Configure Modify

iSCSI

il

Tools

Dl

Support

Configure > Create Host-to-Logical Drive Mappings
% Create Host-to-Logical Drive Mappings - Select Host @ view Frequently Asked Questions
Mote: If a particular host is not listed, you need to make the host available For mapping using the Configure Host Access {Automatic) task under the Configure Tab,

Select a hast group or host:

ﬁ Storage Partitions - Allowed: 4 Used: 1

Mote: If you wank to map a logical drive ko more than one host, you must first create a host group using the Create Host Group bask under the Configure tab,

cos |

Figure 16. Select host area

3. When the Select Logical Drives area is displayed, select the logical drives that
you want to map to the specified host, and click Finish.

Managing iSCSI settings (DS3300 only)

Note: The iSCSI tab on the Subsystem Management window is available only for
DS3300 storage subsystems.

On the Subsystem Management window, click the iSCSI tab. A window similar to
the one in the following illustration opens.
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ortfailover IBM System Storage DS3000 Storage Manager 2 {Subsystem Managenn:
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Configure Modify

O

Support

M \

Tools iSCSI

Summany
Manage iSCSI Settings

Authentication

Change Target Suthertication
Chooze which authertication methods will be required in order for an intistor to access the target. You will alzo define the permissions needed for each
authertication method if recuired

Enter Mutual Authentication Permissions
R) This task iz only required if sty of the defined intistors reguire mutusl authentication. “You can enter the intistor's permissions in this task in order for the
target to access the intistor. Mote that this task is used to enter secret words that have already been defined on the inttiator's host

Identification and networking

@ Change Target Idertification
Define an easy-to-remember alias for the target for easy idertification. You can also find the target's ISCEl name in this task.

@ Change Target Discovery
Corfigure parameters for hiow the target wil be discovered on the network, such a3 ISNS server settings.

@$ Configure iSCS Host Parts
Configure network paratneters for the iISCSl host ports onthe controller(s) such as 1P configuration and other advanced functions.

Sessions and statistice

WiewEnd ISCE| Sessions
Wiew detailed iSCSl sessions and cannection information and end iISCEl sessions.

Wiewy ISCEl Statistics
=1 Yiew and save iISC3| port and target statistics for thiz storage subsystem.

Figure 17. Manage iSCSI settings page

The following options are available from the iSCSI page:
» Change Target Authentication

* Enter Mutual Authentication Permissions

» Change Target Identification

» Change Target Discovery

» Configure iISCSI Host Ports

* View/End iSCSI Sessions

* View iSCSI Statistics
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Changing target authentication

Select Change Target Authentication to specify the target challenge handshake
authentication protocol (CHAP) secret that the initiator must use during the security
negotiation phase of the iSCSI login. By default, None is selected. To change the
selection, click CHAP, and then type the CHAP secret. You can select the option to
generate a random secret if you want to. This enables 1-way CHAP.

Entering mutual authentication permissions

Before you select Enter Mutual Authentication Permissions, you must define a
host port for the initiator and enable Target Authentication. After the host port is
listed, select the host from the list and click Chap Secret to specify the secret that
is passed to the initiator from the target to authenticate it. This enables Mutual
CHAP (2-way).

Changing target identification
Select Change Target Identification to specify a target alias that is to be used
during device discovery. You must provide a unique name for the target that
consists of fewer than 30 characters.

Note: You will connect to the target by using the fully qualified IQN that is listed
above the alias.

Changing target discovery

Select Change Target Discovery to perform device discovery by using the iSCSI
simple naming service (iISNS). After you select this option, select the Use iSNS
Server check box. You can also select whether the iISNS server is discovered using
a DHCP server on your network, and you can manually specify an Internet Protocol
version 4 (IPv4) or IPv6 address. When you click the Advanced tab, you can
assign a different TCP/IP port for your iSNS server for additional security.

Note: To provide the required port login information for correct device discovery, all
iISCSI ports must be able to communicate with the same iSNS server.

Configuring iSCSI host ports

Select Configure iSCSI Host Ports to configure all of the TCP/IP settings. You can
choose to enable or disable IPv4 and IPv6 on all of the ports. You can also
statically assign IP addresses or let them be discovered using DHCP. Under
Advanced IPv4 Settings, you can assign VLAN Tags (802.1Q) or set the Ethernet
Priority (802.1P). Under Advanced Host Port Setting, you can specify a unique
iSCSI TCP/IP port for that target port. You can also enable Jumbo Frames from this
option. The supported frame sizes are 1500 and 9000.

Viewing or ending an iSCSI session
Select View/End iSCSI Sessions to view all of the connected iSCSI sessions to
the target. From this page, you can also close an existing session by forcing a
target ASYNC logout of the initiator session.

Viewing iSCSI statistics

Select View iSCSI Statistics to view a list of all iISCSI session data, for example,
the number of header digest errors, number of data digest errors, and successful
protocol data unit counts. You can also set a baseline count after a corrective action
to determine whether the problem is solved.
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Determining firmware levels

Method 1

There are two methods for determining the DS3000 storage subsystem, expansion
unit, drive, and ESM firmware versions. Each method uses the Storage Manager
Client that manages the DS3000 storage subsystem with the attached expansion
unit.

Open the Subsystem Management window and click the Summary tab. Select
Storage Subsystem Profile in the Hardware Components area. When the
Storage Subsystem Profile window opens, select one of the following tabs to view
the firmware information.

Note: The Storage Subsystem Profile window contains all the profile information for
the entire subsystem. Therefore, you might have to scroll through a large
amount of data to find the information that you want.

Summary

* Firmware version (controller firmware)
* NVSRAM version

The following example shows the profile information on the Summary page.

o5 Storage Subsystem Profile. L x|
E Logical Drives | Drives | aDrive Channels | ﬂ'i Enclozures | ﬁ Mappings | %A\I
[z2] Surmmary | [ cortralers % Arrays
Current configuration ;I
Firmware version: 96.17.41.03
NVIRAM version: N1726D3ZLRA1TVO3
Pending configquration
Staged firmware dowmload supported: Yes
Firmware wersion: Nome
NVSRAM version: None J
Transferred on: Nome
Controller enclosure audible alarm: Disghled
NWSRLM ~enfirnirad For kattearieas Vas LI
Find:
-] # Save As | Close | Help |
Results:

Figure 18. Example of profile information on the Summary page
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Controller

* Firmware version

* Appware version (Appware is a reference to controller firmware)
* Bootware version (Bootware is a reference to controller firmware)
* NVSRAM version

The following example shows the profile information on the Controller page.

52 Storage Subsystem Profile |

8 Logical Drives | a Drives I a Drive Channels | E'ﬁ Enclosures | ﬁ Mappings | All
B Summary ! Cortrollers % Arrays
Controller in Enclosure 0, Hlot A ;l
Status: Online —I
Current configquration
Firmware wersion: 96.17.41.03
Appware wersion: 96.17.41.03
Bootware wersion: 96.17.41.03
HVSRAM wersion: H1726D3ZLRIL7V03
Pending configuration
Firmware version: Hone
innuare wersinm: Hene =l
Find:
I X 33 Save As.. | Cloze | Help |
Results:

Figure 19. Example of profile information on the Controller page

Enclosures
e Firmware version

The following example shows the profile information on the Enclosures
page.

F5: storage Subsystem Profile . |

E Summary | ! Cortrollers | % Arrays
E Logical Drives | Drives a Drive Channels E‘i Enclosures | ﬁ Mappings All
Date of mamifacture: Jamuary 1, 2006 _:I
Z E5ZM Canisterszs Detected
ESM card status: Optimal -
Firmware wersion: 0164
Maximim data rate: 3 Ghp=
Current data rate: 3 Ghps
Location: 4 (left)
Card communication: 1):4
Drndnct TTe FYRRANA j
Find:
I ;I El Save bz | Cloze Help
Resuts:

Figure 20. Example of profile information on the Enclosures page

DS3000 Storage Manager Installation and Support Guide for AIX and Linux on POWER



Method 2

Drives
* Firmware version (drive firmware)

The following example shows the profile information on the Drives page.

£E Storage Subsystem Profile il x|
@ Summary | ! Cortrolers | % Arrays
E Logical Drives Drives | = Drive Charnels | E'i‘ Enclosures | ﬁ Mappings | @ All
PROFILE FOR STORAGE SUBSYSTEM: SIMPLEX (10/24/06 7:21:00 PH) =
DRIVE.
SUMMARY

Bumber of driwes: 1
Current drive types: Serial Attached 3C3I (34%3) (1)

BASIC:

TRAY, SLOT STATUS CAPACITY TYPE CURRENT DATA RATE PRODUCT ID FIRMWARE VERSION
0, 1 Optimal 33.902 GB 5&35 3 Ghps ST33675455 Bald
%
4] _*l_‘
Find:
Iﬁ & Save As... | { Close Help |

Results:

Figure 21. Example of profile information on the Drives page

Open the Subsystem Management window and select Download Firmware on the
Support page. Select one of the following options to view the firmware information.

Note: Use method 2 only to make sure that the firmware versions are correct. After
you check the firmware versions, cancel or close the windows to avoid
downloading firmware unintentionally.

Download controller firmware

» Firmware version (controller firmware)
* NVSRAM version

Download NVSRAM
* NVSRAM version
Download drive firmware
» Firmware version (drive firmware)

Download Environmental Services Monitor (ESM) firmware
* Enclosure firmware version

Downloading controller, NVSRAM, ESM, and hard disk drive firmware

This section provides instructions for downloading DS3000 storage subsystem
controller firmware and NVSRAM, EXP3000 ESM firmware, and drive firmware. The
DS3000 storage subsystem firmware download sequence is as follows:

» Controller firmware

* NVSRAM

* ESM firmware

» Hard disk drive firmware
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Important: Stop all /O activity while you download firmware and NVSRAM to a
DS3000 storage subsystem, because you will lose the connections
between the host server and the DS3000 storage subsystem.

Note: You can download the latest versions of DS3000 storage subsystem
controller firmware, NVSRAM, EXP3000 ESM, and hard disk drive firmware
at |http://www.ibm.com/servers/storage/support/disk/|

Downloading controller or NVSRAM firmware

To download the DS3000 storage subsystem controller firmware and NVSRAM,
complete the following steps:

1. From the Enterprise Management window, open the Subsystem Management
window by double-clicking a storage subsystem.

2. Click Support » Download firmware » Download Controller Firmware. The
Download Controller Firmware window opens, as shown in|Figure 22,

5 Download Contraller Firmware

Select a firmvare file to transfer new controller firmyvare from this management station to Storage
Subsystem FLLL,

\ Cartroller Firmuwar

Currert cortroller firmware version: Proinfo 9617 41 05

Selected controller firmvare file:

[ i seectie: 1|

File informetion:

I Tranater NYSRAM file with controler fimwvare
Currert NVSRAM version: N17260320R317Y14

Selected VERAN e
[ Select Fils

File: infiormetion:

Transter. Cancel Help

Figure 22. Download Controller Firmware window

3. To select the controller firmware file, click Select File next to the Selected
controller firmware file field, and then browse to the file that you want to
download.

4. To select the NVSRAM file, click Select File next to the Selected NVSRAM file
field, and then browse to the file that you want to download.

To transfer the NVSRAM file with the controller firmware, select the Transfer
NVSRAM file with controller firmware check box.

5. Click Transfer.
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Downloading ESM firmware
To download the ESM firmware, complete the following steps.

Note: Downloading ESM firmware must be performed with all I/O quiesed.

1. In the Subsystem Management window, click Support »+ Download firmware »
Download Environmental (ESM) Card Firmware. The Download
Environmental (ESM) Card Firmware window opens.

&= Download Environmental (ESM) Card Firmware . X

Select a firmware file to transter new firmveare from this management station to the selected environmental (ESM) cards on Storage
Subsystem FC.

- Drive enclosur
Select enclosures: [~ Select Al

Enclosure 1D Card

hianufacturer

Card &
Firmrare

Maximum Card A Card B
Dsts Rete Product ID Product D
Enclosure 1 |3 Ghps lEm-ESKS  |0158 IPn 2120400 |0158 IPn 2120400 | |

Card B
Firmarare

Status

~ESM firmweare

Selected ESM firmware file information:

Select File.,.

Please select enclosures and specify firmware file.

Start | Cloze | Help |

Figure 23. Download Environmental (ESM) Card Firmware window

2. Select the Select All check box to direct the download to all enclosures. You
can also select one enclosure or combinations of enclosures by pressing the
Ctrl key while you select the individual enclosures.

3. To select the ESM firmware file, click Select File next to the Selected ESM
firmware file information field, and then browse to the file that you want to
download.

4. Click Start to begin the ESM firmware download. A Confirm Download window
opens.

5. Type yes and click OK to start the download process.

6. When the ESM firmware download for all selected enclosures is completed,

click Close.

Automatic ESM firmware synchronization

When you install a new ESM in an existing storage expansion enclosure that is
connected to a DS3000 storage subsystem that supports automatic ESM firmware
synchronization, the firmware in the new ESM is automatically synchronized with
the firmware in the existing ESM. This resolves any ESM firmware mismatch
conditions automatically.

Note: Automatic ESM firmware synchronization can be performed only after an

ESM firmware file is successfully downloaded to an ESM in the storage
expansion enclosure.
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To enable automatic ESM firmware synchronization, make sure that your system
meets the following requirements:

* The Storage Manager Event Monitor is installed and running.

» The DS3000 storage subsystem is defined in the Storage Manager Client
(SMclient) Enterprise Management window.

Downloading drive firmware

This section provides instructions for downloading DS3000 drive firmware. For more
information, see the online help.

Important: Before you start the drive firmware download process, complete the
following tasks:

» Stop all /0 activity before you download drive firmware to a DS3000
storage subsystem.

+ Unmount the file systems on all logical drives that access the drives
that you select for firmware upgrade.

» Complete a full backup of all data on the drives that you select for
firmware upgrade.

To download the drive firmware, complete the following steps:

1. On the Enterprise Management window, open a subsystem management
window by double-clicking a storage subsystem.

2. Click Support » Download firmware » Download Drive Firmware. The
Download Drive Firmware windows opens.

&5 Download Drive Firmware - Select Packages L. 3|

Select the drive firmware packages you would like to transfer. If you have more than one type of drive (vendor shd capscty), you
may select up to four packages to franster at a time.

~Current drive firrware package information

Drive product ID= and firmware versions: ST33673455(BA18)

~Selected package:

Packages to be transterred:

Remove

Package information:
Crivie vendor:
Drive product ID:
Proposed firnware:
Compstible firmware:

et = Cancel | Help |

Figure 24. Download Drive Firmware window

3. Click Add to locate the server directory that contains the firmware that you
want to download.

4. Select the firmware file that you want to download and click OK. The file is
then listed in the Selected Packages area.

5. Select the firmware file for any additional drive types that you want to
download, and click OK. The additional files are then listed in the Selected
Packages area. A maximum total of four drive types are possible.
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6.

7.

Click Add to repeat step until you have selected each firmware
file that you want to download.

When you have finished specifying the firmware packages for download, click
Next.

In the Select Drive window (shown in , click the Compatible Drives
tab. The Compatible Drives page contains a list of the drives that are
compatible with the firmware package types that you selected. Press and hold
the Ctrl key while you use the mouse to select multiple drives individually, or
press and hold the Shift key while you use the mouse to select multiple drives
that are listed in series. The compatible firmware that you selected in steps
fon page 96/and |5 on page 96|are downloaded to the drives that you select.

2 pownload Drive Firmware - Select Drives

The fallowing tables display drives that are compatible and incompatible with the packages you selected. You may update the
firmvare on one or multiple drives, even if they are not &t the same initial firmvware level. Select the drives you wish to update st
thiz time.

Important: You must stop all [/0 and unmount any file system on sl logical drives accessing the selected drives before starting
the transfer process

~Selected firmyware packages G
Drive product ID= and firmware versions: ST33675455(BA18) ‘

Selectdrives: [ Select al

Cornpativle Drives I Incompatible Drives I

‘ endor |Product ID|EncIosure Slat Type Current 1...| Propose. .. Status Array Mode

Selectediavailable drives: 141

= Back Finizh... Cancel | Help I

Figure 25. Select Drive window

9.

10.

Note: The firmware packages that you select to download should be listed on
the Compatible Drives page. If the product ID for your drive matches
the firmware type but it is not listed as compatible on the page, contact
your technical-support representative for additional instructions.

Click Finish to initiate the download of the drive firmware to each compatible
drive that you selected in step .

When the Download Drive Firmware warning window opens and the message
Do you want to continue? is displayed, type yes and click OK to start the
drive firmware download. The Download Progress window opens, as shown in
[Figure 26 on page 98 Do not intervene until the download process is
completed.
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Xl Download Drive Firmware - Progress

Drives updated:

“endor | Product 1D I Enclosure I it I Type IPerosed Flr...l Array | Status | Progress |
hy

Progress summary -

I
1
|

IEM-ESKS ST3I3E7H455 0 1 SAS B&18 1 Optirmal Successful

|
 Scheduled In progress Failed-partis| Failed-invalid state  Failed-other Mot attempted Successtul
a a

a a 1} 1

Transter More... | Slop | Save As... | Close | Help |

Figure 26. Download Progress window

11.

12.

Every drive that is scheduled for firmware download is designated as in
progress until it is designated as successful or failed.

If the download for a drive fails, complete the following steps:
a. Click the Save as button to save the error log.

b. On the Subsystem Management window, click Support » View Event Log
and complete the following steps to save the storage subsystem event log
before you contact your technical-support representative:

1) Click Select all.

2) Click Save as.

3) Provide a file name to which to save the log.
When the Close button is active, the drive firmware download process is
completed.
Click Close.

Performing other storage-subsystem management tasks

Th

e following list describes other storage-subsystem management tasks that you

can perform. You can perform the following tasks from the Subsystem Management
window.

Create hot spares (Configure » Configure Hot Spares)

Automatically create logical drives and hot spares (Configure » Automatic
Configuration)

Edit host topology configurations for the subsystem (Modify + Edit Topology)

Enter or change a storage subsystem password (Tools » Set or Change
Password)

View or change media scan settings (Tools » Change Media Scan Settings)
Locate a storage subsystem or its components (Tools » Locate)
View or enable premium features (Tools » View/Enable Premium Features)

Change enclosure identification numbers for a storage subsystem (Tools -
Change Enclosure ID Numbers)
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» Synchronize controller clocks (Tools » Synchronize Controller Clocks)

* Change the network configuration (Tools » Change Network Configuration)

* Reset the battery age (Tools » Reset Battery Age)

* Inherit system settings from the operating system (Tools » Inherit System
Settings)

* View the major event log (Support » View Event Log)

» Save all storage subsystem data (Support » Gather Support Information)

» Place controller online or offline (Support + Manage Controllers)

For more information about these and other storage-subsystem management tasks,
see the applicable topics in the Subsystem Management online help.

For advanced users: You can perform other storage-subsystem management
tasks from the Enterprise Management window by clicking Tools » Script Editor.
For more information, see the Enterprise Management window online help.

Note: If there is a problem with the storage subsystem, a Needs Attention status
icon is displayed in the Enterprise Management window next to the storage
subsystem. In the Subsystem Management window, a Storage Subsystem
Needs Attention link is displayed in the status area of the Summary page.
You can click the link to open the Recovery Guru. You can also open the
Recovery Guru by clicking Support » Recover from Failure in the
Subsystem Management window.

Best practices guidelines for the DS3300

For the best performance of the Storage Manager software and the DS3300, follow
the guidelines in the following sections.

iISNS best practices

Using DHCP

There are many considerations for using an iISNS server correctly. Make sure that
you correctly assign your iSNS server address that is provided during the DHCP
lease discovery of your initiator or target. This enables ease of discovery when you
use software initiator-based solutions. If you are unable to do this and must
manually assign the iSNS server to your software or hardware initiators, you should
make sure that all ports for both the DS3300 target and the iSCSI initiator are in the
same network segment (or make sure that the routing between the separate
network segments is correct). If you do not do this, you will be unable to discover
all ports during the iISCSI discovery process, and you might not be able to correctly
perform a controller or path failover.

Using DHCP for the target portals is not recommended. If you use DHCP, you
should assign DHCP reservations so that leases are maintained consistently across
restarts of the DS3300 storage subsystem. If static IP reservations are not provided,
the initiator ports can lose communication to the DS3300 controller and might not
be able to reconnect to the device.

Using supported hardware initiators

As of the date of this document, the only supported hardware initiator is the QLogic
iSCSI Expansion Card for IBM @server BladeCenter.
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Using IPv6

All of the hardware initiators that are supported use the same base firmware code
and the SANsurfer management application. Before you install and configure these
adapters, make sure that you have installed the latest management application and
the latest firmware code. After you confirm this, configure each adapter one at a
time.

To make sure that failovers are performed correctly, connect each adapter by using
one of the following two basic configurations:

» If you have a simple configuration in which all adapters and target ports are in
the same network segment, each adapter should be able to log in to any target
port.

* If you have a complex configuration, each adapter is allowed a single path to
each controller device.

To log in correctly to all available target ports from the hardware initiator, complete
the following steps.

Note: Failure to perform the steps in the following procedure might result in path
failover inconsistencies and incorrect operation of the DS3300.

Start the SANsurfer management utility.

Connect to the system that is running the glremote agent.
Select the adapter that you want to configure.

Select Port 0 or Port 1 for the adapter.

Click Target Settings.

Click the plus sign (+) in the far right of the window.

Type either the IPv4 or IPv6 address of the target port to which you want to
connect.

8. Click OK.
9. Select Config Parameters.
10. Scroll until you see ISID.

11. For connection 0, the last character that is listed should be 0. For connection
1, it should be 1, for connection 2, it should be 2, and so on.

12. Repeat steps|§| throughfor each connection to the target that you want to
create.

13. After all of the sessions are connected, select Save Target Settings.

N oo~ D~

If you are using the QLogic iSCSI Single-Port or Dual-Port PCle HBA for IBM
System x™ to support IPv6, you should allow the host bus adapter firmware to
assign the local link address.

The DS3300 supports the Internet Protocol version 6 (IPv6) TCP\IP. Note that only
the final four octets can be configured if you are manually assigning the local link
address. The leading four octets are fe80:0:0:0. The full IPv6 address is required
when you are attempting to connect to the target from an initiator. If you do not
provide the full IPv6 address, the initiator might fail to be connected.

Network settings

Using the DS3300 in a complex network topology introduces many challenges. If
possible, try to isolate the iISCSI traffic to a dedicated network. If this is not
possible, follow these suggestions:
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» If you are using a hardware-based initiator, the Keep Alive timeout should be 120
seconds. To set the Keep Alive timeout, complete the following steps:

1. Start the SANsurfer Management Utility and connect to the server.
2. Select the adapter and the adapter port that is to be configured.
3. Select the port options and firmware.

The default connection timeout is 60 seconds. This setting is correct for
simple network topologies; however, if a network convergence occurs and
you are not using Fast Spanning Tree and separate spanning tree domains,
in a more complex configuration, you might encounter I/O timeouts.

+ If you are using a Linux software initiator to connect to the DS3300, modify the
ConnFailTimeout to account for the spanning tree issue that is described in step
The ConnFailTimeout value should be set to 120 seconds.

Operating system consideration

For the best performance, do not enable Data and Header Digest when using the
embedded Software Initiators with the Red Hat Enterprise Linux 4 and SUSE Linux
Enterprise Server 9 operating systems. If these functions are enabled, you will see
degraded performance and in the case of multiple hosts accessing the same
DS3300 storage subsystem, you might see that a path is marked incorrectly as
having failed.

SATA disk drive best practices guidelines

If you use a stripe size of 8 KB, you cannot perform a format of a Linux ext2 file
system on a logical drive configured with SATA drives. For the best performance,
use a stripe size of 32 KB or larger when using SATA disk drives.

Fibre Channel best practices guidelines

If you install your Linux host with the QLogic host bus adapter installed in the host,
the default device driver provided with the distribution is installed. This device driver
has embedded failover support enabled that prevents the correct discovery of all
available controller paths. You must install the most current HBA device drivers that
are provided for your solution and make sure that the ramdisk image is remade with
those device drivers before you install the MPP failover driver. Failure to do so
results in incorrect controller and path failover.

Storage Manager 2 Enterprise Manager view and Subsystem
Management view best practices guidelines

Consider the following information before you use the Storage Manager 2

Enterprise Management view and Application Management view:

* The current command to gather performance statistics (save storagesubystem
performancestats=filename.xls;) does not gather any valid data. All of the values
are zero (0). As of the date of this document, there is no workaround available.

» To create a logical drive using the smcli or Enterprise Manager script editor you
must make nsure that the syntax of the command is correct. When you specify a
logical drive size, the correct syntax is:

create logicalDrive array[array_number] capacity=size_of logical_drive TB/GB/MB;

Note: There must be a space before TB/GB/MB; otherwise, the command does
not work.
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* The Storage Manager 2 Application Management view is limited to creating a
maximum of 64 FlashCopies and 128 VolumeCopies. However, using the
Storage Manager command-line interface enables a maximum of 128
FlashCopies and 255 VolumeCopies to be created.

* If you are updating a DS3000 storage subsystem, the first controller firmware
download might fail. If this occurs, start the firmware download a second time
and verify that the firmware is successfully downloaded. If the firmware download
fails again, contact your IBM technical-support representative.

» To expand a logical drive using the smcli or Enterprise Manager script editor you
must make nsure that the syntax of the command is correct. When you specify a
logical drive size, the correct syntax is:

set logicalDrive[logical drive name]
addCapacity=size_to_increase_logical_drive_by TB/GB/MB;

Note: There must be a space before TB/GB/MB; otherwise, the command does
not work.

» If you are using a firewall between your management client and the host agent
that is managing the controller or the controller TCP/IP address, make sure that
you have created an exclusion for TCP/IP port 2463. This port is used by the
Storage Manager software to communicate to the storage subsystem.

 If you perform an upgrade to the Storage Manager software from any previous
version to Storage Manager version 02.70.xx.xx, you must perform a new
discovery of all your storage subsystems again. The previous management
domain is not maintained.
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Chapter 6. Completing storage-management tasks

This chapter provides information about how to use the SMdevices utilities, start
and stop the host-agent software, and uninstall the Storage Manager software.

Using the SMdevices utility

The SMutil software includes a utility, SMdevices, that you can use to view the
storage subsystem logical drive that is associated with an operating-system device
name. This utility is helpful when you want to map host system LUNs with DS3000
LUNSs.

Note: The SMdevices command does not function with the DS3300 storage
subsystem.

When you are finished creating the logical drives on a storage subsystem, to use
SMdevices, complete the following steps on the host that is attached to that storage
subsystem:

1. At a command prompt, change to the util directory, where the IBM DS3000
Storage Manager software is installed on your host system.

2. Enter the following command:
# SMdevices

The software displays the following device identification information:

/dev/sdb (/dev/sgl) [Storage Subsystem CGG_SATA Test, Logical Drive data-1,
LUN 0, Logical Drive ID <600a0b80001d2b9500004d80469bbb18>,
Preferred Path (Controller-A): In Use]

In this example:

* /dev/sdb (/dev/sg1) is the disk number that is displayed in Disk Administrator
* CGG_SATA Testis the name of the DS3000 storage subsystem

» data-1is the name of the logical drive

* LUN Ois the LUN that is associated with the logical drive

Stopping and restarting the host-agent software

You must stop and restart the host-agent software if you add storage subsystems to
the management domain of the host-agent software. When you restart the service,
the host-agent software discovers the new storage subsystems and adds them to
the management domain.

Note: If none of the access logical drives are detected after a restart, the
host-agent software automatically stops running. Make sure that the Fibre
Channel or iSCSI connection from the host to the SAN to which the DS3300
or DS3400 storage subsystem is attached is working correctly. Then, restart
the host or cluster node so that new host-agent-managed storage
subsystems can be discovered.

To stop and restart the host-agent software, use the following commands:

# SMagent start starts the SMagent

# SMagent stop stops the SMagent
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Uninstalling storage management software components

Use the following procedure to uninstall one or more of the components of the
Storage Manager 2 software. Existing storage array mappings and storage partition
configurations are retained during software removal and will be recognized by the
new client software.

Important:Do not uninstall the MPIO PCM or RDAC MPP device driver unless you
are instructed to do so by your technical-support representative.

To uninstall the Storage Manager 2 software, complete the following steps:
1. Open a terminal window and change to the Uninstall IBM_DS3000 directory.
2. Enter the following command:
# sh Uninstall_IBM_DS3000
3. Choose one of the following uninstall options:
a. Completely remove all features and components
b. Choose specific features that were installed
4. Select option a and press Enter to complete the uninstall process.
5. Select option b and then select from the following features to uninstall:
» Storage Manager 2 Client
« Storage Manager 2 Utilities
» Storage Manager 2 Agent

Enter the number of the feature that you want to uninstall and press Enter to
complete the uninstall process.
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Chapter 7. Enabling and using premium features

Premium features provide enhanced functionality that enables you to perform tasks
that might be limited or unavailable with your base storage subsystem model.

You can purchase the following premium features for a DS3000 storage subsystem:
» DS3200 Software Feature Pack

» DS3300 Software Feature Pack

» DS3400 Software Feature Pack

« DS3000 FlashCopy Expansion License

» DS3000 Volume Copy License

+ DS3000 FlashCopy Volume Copy License

» DS3000 Partition Expansion License

For information about how to purchase a premium feature, contact your IBM
marketing representative or authorized reseller.

Obtaining the activation key file and enabling a premium feature

Follow the Activation Instructions document that comes with your premium feature
to obtain the activation key file. The activation key file is required by the Storage
Manager software to enable the premium feature.

Enabling the Software Feature Pack

You must first enable the Software Feature Pack for your DS3000 product before
you can enable the following premium features:

» DS3000 FlashCopy Expansion License

» DS3000 Volume Copy License

+ DS3000 FlashCopy Volume Copy License
» DS3000 Partition Expansion License

After you obtain the activation feature pack key file from the IBM Web site,
complete the following steps to enable the Software Feature Pack in the Storage
Manager software:

1. Open the Subsystem Management window and click Tools » Enable Feature
Pack. The Select Feature Pack Key File window opens.

2. Select the feature pack key file that you obtained from the IBM Web site and
click OK.

3. After the feature pack is enabled, enable premium features by using the feature
keys that you purchased.

Note: You have to enable the Software Feature Pack only one time before you can
enable premium features. Premium feature keys can be obtained and
applied anytime after you enable the feature pack. For questions about
obtaining a feature key, contact your IBM marketing representative or
authorized reseller.
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Enabling the DS3000 Partition Expansion License

You can upgrade the DS3000 Partition Expansion License from 4 to 16 partitions for
the storage subsystem. After you have obtained the DS3000 Partition Expansion
License key, to enable this feature in the Storage Manager software, complete the
following steps:

1.

2.

Open the Subsystem Management window and click Tools » View/Enable
Premium Features.

Under Enabled Premium Features, click Upgrade a feature, as shown in

Figure 27

F& FULL IBM System Storage DS3000 Storage Manager 2 (Subsystem Management)
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Disabled Premium Features
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m FlashCopy Logical Drives
@ Logical Drive Copy

Feature Eriable Identifier: [31353904360091 353639390045407805

Close

Figure 27. View/Enable Premium Features window

The Select Feature Key File window opens.

Select the feature key file that you obtained from the IBM Web site and click
OK.

In the Enable Premium Feature window, click Yes.

Enabling the DS3000 FlashCopy Expansion License

After you have obtained the DS3000 FlashCopy Expansion License key, to enable
this feature in the Storage Manager software, complete the following steps:

1.

Open the Subsystem Management window and click Tools » View/Enable
Premium Features.

Under Disabled Premium Features, click Enable a feature, as shown in
[Figure 27 The Select Feature Key File window opens.

Select the feature key file that you obtained from the IBM Web site and click
OK.

In the Enable Premium Feature window, click Yes.

106 DS3000 Storage Manager Installation and Support Guide for AIX and Linux on POWER



Enabling the DS3000 VolumeCopy License

Note: The terms VolumeCopy and Logical Drive Copy are used interchangeably
throughout this document, the Storage Manager Client program interface,
and the online help.

To enable the DS3000 Volume Copy License, complete the following steps:

1. Open the Subsystem Management window and click Tools » View/Enable
Premium Features.

2. Under Disabled Premium Features, click Enable a feature, as shown in
|Figure 27 on page 106l The Select Feature Key File window opens.

3. Select the feature key file that you obtained from the IBM Web site and click
OK.

4. In the Enable Premium Feature window, click Yes.

Using the FlashCopy premium feature

A FlashCopy logical drive is a logical point-in-time image of a logical drive, called a
base logical drive. A FlashCopy logical drive has the following features:

» |t is created quickly and requires less disk space than an actual logical drive.

* |t can be assigned a host address, so that you can perform backups by using the
FlashCopy logical drive while the base logical drive is online and accessible.

* You can use the FlashCopy logical drive to perform application testing or both
scenario development and analysis. This does not affect the actual production
environment.

* The maximum number of FlashCopy logical drives that is allowed is one-half of
the total logical drives that are supported by your controller model.

For more information about the FlashCopy feature and how to manage FlashCopy
logical drives, see the Subsystem Management online help.

Important: The FlashCopy drive cannot be added or mapped to the same server
that has the base logical drive of the FlashCopy logical drive in a Windows Server
2003 or NetWare environment. You must map the FlashCopy logical drive to
another server.

To create a FlashCopy logical drive, complete the following steps:

1. To make sure that you have the accurate point-in-time image of the base logical
drive, stop applications and flush cache 1/O to the base logical drive.

2. Open the Subsystem Management window, click Configure » Create
FlashCopy Logical Drive, and follow the instructions in the wizard.

3. For instructions for adding the FlashCopy logical drive to the host, see the
Subsystem Management online help

Note: To manage created FlashCopy Logical Drives, click the Modify tab and
select Modify FlashCopy Logical Drives. Select Disable FlashCopy
Logical Drives, Re-create FlashCopy Logical Drives, or Expand the
FlashCopy Repository and then follow the instructions in the wizard.
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Using VolumeCopy

The VolumeCopy feature is a firmware-based mechanism for replicating logical
drive data within a storage array. This feature is designed as a
systems-management tool for tasks such as relocating data to other drives for
hardware upgrades or performance management, data backup, or restoring
snapshot volume data. You submit VolumeCopy requests by specifying two
compatible drives. One drive is designated as the source and the other as the
target. The VolumeCopy request is persistent so that any relevant result of the copy
process can be communicated to you.

For more information about the VolumeCopy feature and how to manage
VolumeCopy logical drives, see the Subsystem Management online help.

To create a VolumeCopy, open the Subsystem Management window, click
Configure » Create Volume Copy, and follow the instructions in the wizard

Note: To manage created VolumeCopy logical drives, click Modify + Manage
Logical Drive Copies. A list of VolumeCopy requests is displayed. For each
VolumeCopy, select Re-Copy or Stop, and to modify attributes, select
Permissions and Priority. |Figure 28 shows this tool.

ﬁUPN_SS IBM System Storage DS3000 Storage Manager 2 {Subsystem Management)
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Priority ... |
Retmove |

Source Logical Drive

Target Logical Drive
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4 Read-only logical drives

Close

Figure 28. Manage Logical Drive Copies window
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Appendix A. Storage subsystem and controller information
record

provides a data sheet for recording storage subsystem names,
management types, Ethernet hardware addresses, and IP addresses. Make a copy
of this table and complete the information for your storage subsystems and
controllers. Use the information to set up the BOOTP table for the network server
and the host or Domain Name System (DNS) table. The information is also helpful
if you add storage subsystems after initial installation. Each column heading
includes a page reference for detailed instructions for obtaining the information. For
a sample information record, see [Table 8 on page 20}

Table 12. Storage subsystem and controller information record

Storage
subsystem Management Controllers: Ethernet and IP addresses, and Host: IP address and host
name (page[20) |method (page[7) |host name (pages [20]and [21) name (page [21)
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Appendix B. Accessibility

This section provides information about alternative keyboard navigation, which is an
accessibility feature of the DS3000 Storage Manager software. Accessibility features
help a user who has a physical disability, such as restricted mobility or limited
vision, to use software products successfully.

By using the alternative keyboard operations that are described in this section, you
can use keys or key combinations to perform Storage Manager tasks and initiate
many menu actions that can also be done with a mouse.

In addition to the keyboard operations that are described in this section, the
DS3000 Storage Manager 2 software installation package for Windows includes a
screen reader software interface. To enable the screen reader, select Custom
Installation when you use the installation wizard to install the Storage Manager 2
software on a Windows host or management station. Then, in the Select Product
Features window, select Java Access Bridge in addition to the other required host
software components.

Keyboard focus is not always clearly shown in the panes of the help viewer window.
If you cannot see where the keyboard focus is, press Ctrl+F1. If the focus is on the
Back, Forward, Print, or Page Setup button in the toolbar, the alternative text for the
button is displayed. If alternative text is not displayed, keyboard focus is not on a
button. Press Ctrl+Tab to see whether the focus is on one of the navigator tabs
(Contents tab, Index tab, or Search tab). If the focus is on one of the navigation
tabs, press Shift+Tab to change the focus to the toolbar pane.

defines the keyboard operations that you can use to navigate, select, or
activate user interface components. The following terms are used in the table:

» Navigate means to move the input focus from one user interface component to
another.

» Select means to choose one or more components, typically for a subsequent
action.

* Activate means to carry out the action of a component.

In general, navigation among components requires the following keys:

» Tab: Moves keyboard focus to the next component or to the first member of the
next group of components

» Shift+Tab: Moves keyboard focus to the previous component or to the first
component in the previous group of components

» Arrow keys: Move keyboard focus among the components in a group of
components

Table 13. DS3000 Storage Manager software alternate keyboard operations

Shortcut Action
F1 Open the Help.
F10 Move keyboard focus to the main menu bar and posts

first menu; use the arrow keys to navigate through the
available options.

Alt+F4 Close the management window.

Alt+F6 Move keyboard focus among windows (non-modal) and
among management windows.
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Table 13. DS3000 Storage Manager software alternate keyboard operations (continued)

Shortcut

Action

Alt+underlined_letter

Access menu items, buttons, and other interface
components by using the keys that are associated with
the underlined letters.

For the menu options, press the Alt+underlined_letter to
access a main menu, and then press the underlined
letter to access the individual menu item.

For other interface components, press
Alt+underlined_letter.

Ctrl+F1 Display or conceal a tool tip when keyboard focus is on
the toolbar.
Spacebar Select an item or activate a hyperlink.

End, Page Down

Move keyboard focus to the last item in the list.

Esc

Close the current window (does not require keyboard
focus).

Home, Page Up

Move keyboard focus to the first item in the list.

Shift+Tab Move keyboard focus through components in the reverse
direction.

Ctrl+Tab Move keyboard focus from a table to the next user
interface component.

Tab Navigate keyboard focus among components or select a
hyperlink.

Down Arrow Move keyboard focus down one item in the list.

Left Arrow Move keyboard focus to the left.

Right Arrow Move keyboard focus to the right.

Up Arrow Move keyboard focus up one item in the list.
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Appendix C. Getting help and technical assistance

If you need help, service, or technical assistance or just want more information
about IBM products, you will find a wide variety of sources available from IBM to
assist you. This section contains information about where to go for additional
information about IBM and IBM products, what to do if you experience a problem
with your system, and whom to call for service, if it is necessary.

Before you call

Before you call, make sure that you have taken these steps to try to solve the
problem yourself:

» Check all cables to make sure that they are connected.

» Check the power switches to make sure that the system and any optional
devices are turned on.

» Use the troubleshooting information in your system documentation, and use the
diagnostic tools that come with your system. Information about diagnostic tools is
in the Problem Determination and Service Guide on the IBM Documentation CD
that comes with your system.

+ Go to the IBM support Web site at|http://www.ibm.com/systems/support/ to check
for technical information, hints, tips, and new device drivers or to submit a
request for information.

You can solve many problems without outside assistance by following the
troubleshooting procedures that IBM provides in the online help or in the
documentation that is provided with your IBM product. The documentation that
comes with IBM systems also describes the diagnostic tests that you can perform.
Most systems, operating systems, and programs come with documentation that
contains troubleshooting procedures and explanations of error messages and error
codes. If you suspect a software problem, see the documentation for the operating
system or program.

Using the documentation

Information about your IBM system and preinstalled software, if any, or optional
device is available in the documentation that comes with the product. That
documentation can include printed documents, online documents, readme files, and
help files. See the troubleshooting information in your system documentation for
instructions for using the diagnostic programs. The troubleshooting information or
the diagnostic programs might tell you that you need additional or updated device
drivers or other software. IBM maintains pages on the World Wide Web where you
can get the latest technical information and download device drivers and updates.
To access these pages, go to |http://www.ibm.com/systems/support/|and follow the
instructions. Also, some documents are available through the IBM Publications
Center at jhttp://www.ibm.com/shop/publications/order/}

Getting help and information from the World Wide Web

On the World Wide Web, the IBM Web site has up-to-date information about IBM
systems, optional devices, services, and support. The address for IBM System x
and xSeries® information is |http://www.ibm.com/systems/x}. The address for IBM
BladeCenter information is jhttp://www.ibm.com/systems/bladecenter} The address
for IBM IntelliStation® information is |http://www.ibm.com/intellistation/.
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You can find service information for IBM systems and optional devices at
Ihttp://www.ibm.com/systems/support/

Software service and support

Through IBM Support Line, you can get telephone assistance, for a fee, with usage,
configuration, and software problems with System x and xSeries servers,
BladeCenter products, IntelliStation workstations, and appliances. For information
about which products are supported by Support Line in your country or region, see
Ihttp://www.ibm.com/services/sl/products/

For more information about Support Line and other IBM services, see
Ihttp://www.ibm.com/services/, or see |http://www.ibm.com/planetwide/| for support
telephone numbers. In the U.S. and Canada, call 1-800-IBM-SERV
(1-800-426-7378).

Hardware service and support

You can receive hardware service through IBM Services or through your IBM
reseller, if your reseller is authorized by IBM to provide warranty service. See
Ihttp://www.ibm.com/planetwide/ for support telephone numbers, or in the U.S. and
Canada, call 1-800-IBM-SERV (1-800-426-7378).

In the U.S. and Canada, hardware service and support is available 24 hours a day,
7 days a week. In the U.K., these services are available Monday through Friday,
from 9 a.m. to 6 p.m.

IBM Taiwan product service

518 IBM 7 i Al 55 T s 7 2

5 9 B oy S B e 2 073 15 PR 22 ]
AL TR 7 5f 3

FE&% 1 0800-016-888

IBM Taiwan product service contact information:
IBM Taiwan Corporation
3F, No 7, Song Ren Rd.
Taipei, Taiwan
Telephone: 0800-016-888
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Appendix D. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Trademarks

The following terms are trademarks of International Business Machines Corporation
in the United States, other countries, or both:

IBM IntelliStation ServerProven
IBM (logo) POWER System Storage
AlX POWER4 System p
BladeCenter POWERS5 System x
FlashCopy POWERG6 TotalStorage
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HACMP PowerPC xSeries

Intel, Intel Xeon, Itanium, and Pentium are trademarks or registered trademarks of
Intel Corporation or its subsidiaries in the United States and other countries.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks of Sun
Microsystems, Inc. in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.
Red Hat, the Red Hat “Shadow Man” logo, and all Red Hat-based trademarks and
logos are trademarks or registered trademarks of Red Hat, Inc., in the United States

and other countries.

Other company, product, or service names may be trademarks or service marks of
others.

Important notes

IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven, including but not limited to the implied warranties of
merchantability and fitness for a particular purpose. These products are offered and
warranted solely by third parties.

IBM makes no representations or warranties with respect to non-IBM products.
Support (if any) for the non-IBM products is provided by the third party, not IBM.

Some software may differ from its retail version (if available), and may not include
user manuals or all program functionality.
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